§ software

Super Natural

Administration

Version 9.2.2

October 2023




This document applies to Super Natural Version 9.2.2 and all subsequent releases.
Specifications contained herein are subject to change and these changes will be reported in subsequent release notes or new editions.

Copyright © 1985-2023 Software AG, Darmstadt, Germany and/or Software AG USA, Inc., Reston, VA, USA, and/or its subsidiaries
and/or its affiliates and/or their licensors.

The name Software AG and all Software AG product names are either trademarks or registered trademarks of Software AG and/or
Software AG USA, Inc. and/or its subsidiaries and/or its affiliates and/or their licensors. Other company and product names mentioned
herein may be trademarks of their respective owners.

Detailed information on trademarks and patents owned by Software AG and/or its subsidiaries is located at
http://softwareag.com/licenses.

Use of this software is subject to adherence to Software AG's licensing conditions and terms. These terms are part of the product
documentation, located at http://softwareag.com/licenses/ and/or in the root installation directory of the licensed product(s).

This software may include portions of third-party products. For third-party copyright notices, license terms, additional rights or re-
strictions, please refer to "License Texts, Copyright Notices and Disclaimers of Third-Party Products". For certain specific third-party
license restrictions, please refer to section E of the Legal Notices available under "License Terms and Conditions for Use of Software AG
Products / Copyright and Trademark Notices of Software AG Products". These documents are part of the product documentation,
located at http://softwareag.com/licenses and/or in the root installation directory of the licensed product(s).

Use, reproduction, transfer, publication or disclosure is prohibited except as specifically provided for in your License Agreement with
Software AG.

Document ID: NSN-ADMIN-922-20231008



Table of Contents

PTEface ....eeeiiiiiiie e e vii
1 About this Documentation ...........cc.cocoiiiiiiiiiiiiiii 1
Document CONVeNtioNS ..........ccoiiiiiiiiiiiiiiiiicccce e 2
Online Information and SUPPOTt .......c.ccieiiiiiiiiiii 2
Data Protection .........c..ooooiiiiiiiiiic 3
2 INErOAUCHION ..o 5
Administration Application OVEIrVIEW ..........cccivviiiiiiiiiiiiiiiiiciie e 6
Administration Application User Interface ............cccccoeviviiiiiiiiiniiniiiin, 7
Invoking the Super Natural Administration Application .............cccocoeiiiiiiinnnnnn 9
Invoking the Super Natural Processor Application from the Administration
APPLCALION .o 11
Command OVEIVIEW ........cccocuiiiiiiiiiiiiiiiiiic s 11
BUSETS vt 13
What are USers? .......coooiiiiiiiiiiiiiiiiciiccic 14
Default User **** % 15
USer Profile ......ocuoiiiiiiiiiiiiiiii 15
Listing USETS ...cciiiiiiiiiiiiiiiiiciiiic 16
USET IS . 18
AddING USETS ...coeiiiiiiiiiiiiiiiiice e 18
Modifying Single USers ...........cccoviiiiiiiiiiiiiiiiiiiiiiccicc e 19
Modifying Multiple USeTSs ...........cccooviiiiiiiiiiiiiiiiccecccc 39
COPYING USEIS vttt 40
Deleting USETS ......ccueiiiiiiiiiiiiciicieece e 40
Importing USerS ........oooiiiiiiiiiiiiiiiii i 40
A IS .o 41
What are File Profiles? ..........cccooiiiiiiiiiiiiiiiic 42
Listing File Profiles ...........cccccoiiiiiiiiiiiiiiiiiiiiiiciic 44
Adding Files ..o 46
Modifying Single Files .........ccccooiiiiiiiiiiiiiiiiiiiiiic s 47
COPYING FileS .o 56
Deleting Files ........coiiiiiiiiiiiiiiiicce e 57
Importing Files .........coooiiiiiiiiiii 57
5 SUPETLILES ..o 59
What are Superfiles? ..o 60
What are Superfile Profiles? ... 61
Listing SUPETfiles ........c.cooiiiiiiiiiiiiiiiiii 62
Adding SUPeTfiles ...........ccooiiiiiiiiii 64
................................................................................................................................... 65
Deleting SUPerfiles ...........cccooiiiiiiiiiiiiiiiiiiiii 73
6 User FIles .....coooiiiiiiii 75
What are User Files? ..........ccoooiiiiiiiiiiiiicc e 76
What are User File Profiles? ............ccccocoiiiiiiiiiiiiii 76
Listing User FIles ........ccccooiiiiiiiiiiiiiiiiiiiiiciccccccccce e 77




Administration

Modifying User Files .........cccccooviiiiiiiiiiiiiiiiiiiiiiice 79
Deleting User Files ..o 87
7 LADTATIS ..ovviiiiiiiiiiiciccccie s 89
What are Libraries? ..o 90
Creating Libraries .........ccccooviiiiiiiiiiiiiiii e 91
Listing LIbTaries ..........cccviiiiiiiiiiiiicccciccccce e 91
Copying Libraries .........ccccooiiiiiiiiiiiiiii e 93
Deleting Libraries .........cccccovviiiuiiiiiiiiiiiiiiiiii i 94
Listing Library Members ............c.cccoooiiiiiiiii 94
Copying Library Members ..........ccccoiiiiiiiiiiiiiiiiiiiicicceicc 96
Deleting Library Members ...........cccocoviiiiiiiiiiiiic 96
The Information / Info FUNCHON ..........cccooiiiiiiiiiiiiii 97
8 Common Library Definitions ...........cccociviiiiiiiiiiiiic 101
What are Common Library Definitions? ...........cccoccooviiiiiiiiiiiiiiiiiiicie 102
Listing Common Library Definitions ..........cccccccevviiiiiiiiiiiiiiiiiiiiecccee, 102
Adding Common Library Definitions ...........cccccooieiiiiiiiiiii, 104
Deleting Common Library Definitions ............cccceoviiiiiiiiiiniiiiiiiiiiiccce 104
9 SPeCial SEIVICES .....ouviiiiiiiiiieiicte e 105
Invoking the Special Services Menu ..........ccccccoocuiiiiiiiiiiiiiiiiiiiii 106
IMPOTting USETIS .....cocuviiiiiiiiiiiiiiii i 108
Importing Files ... 110
Modifying Multiple USeTs .........cccooiiiiiiiiiiiiiiiiiiiiiiieciccccccccc e 112
Layout Standard Title ..........ccoooiiiiiiiii 116
JCL MEIMDETS ..ccoeeieieieeiiieeeeeeeeeeeeeeee 117
10 Batch Processing ...........ccocieiiiiiiiiiiiiiiccieiccccc e 123
What is Batch Processing? ...........ccccoiiiiiiiiiiiiiiiiiiiiiccicie 124
Setting Up Batch Processing ...........cccociiiiiiiiiiiiiiiiiiiiiiiiiic 125
Setting Up Batch Processing for Remote Job Entry - RJE ..o, 126
Writing JCL MEmDETS .......cocviiiiiiiiiiiiiiiiiiiiicciie e 126
Maintaining JCL Members ...........cccooiiiiiiiiiiiiiiicce 128
Notes for Natural Security USErs ..........cccoeviiiiiiiiiiiiiiiiiiiiiecicceecee e, 128
JOD SUDMISSION ....eeiiiiiiiiiieee et e e ettt e e e e e e e nerre e e e e e e e e snnnreeeeeas 130
11 Batch UIHES ...oooviiiiiiii 131
What are Batch Utilities? ............cccocoiiiiiiiiii 132
Unloading and Loading Super Natural Data ...........c..cccooiiiiiii, 132
SINULD .ot 133
SINLOAD .o e 136
SNDELUEF?2 - Deleting User Files in Batch .........cccccociiiiiiiiiniiiiiiicee, 137
SNSORTFI - Sorting File Links in User Profiles .............cccccoiviniiiiiiniiniinnn. 138
12 Exit Programs .........cciiiiiiiiiiiiii e 141
What are Exit Programs? ..........cccccooiiiiiiiiiiiiiiiiiiiiiciee 142
USET EXItS wooiiiiiiiiiiicciicccec e 142
System EXQts .....coocuiiiiiiiiiiiiiii i 144
13 Technical INfOrmation .........cccoccuiiiiiiiiiiiiiiiii 145
Super Natural and Natural .........c.ccocoiiiiiiiiiiii e 146

Administration



Administration

Data Selection and Performance ..........ccoceeeiiiiiiiiiiiiiiniieeiiiccecceccec e 150
SOTE s 151
Personal Database ...........ccccoooiiiiiiiiiiiiiiiiiiii 152
System LImits ......c.occooviiiiiiii 154
Error LOZZING ...cvvviiiiiiiiiiiiiiiiciiicc 155
DDM Check 0N MOify ....oovviiiiiiiiiiiiiiiicccccc 171
Status REPOTLS ......eiiiiiiiiiiiiiiiiiiic 177
Super Natural RPC Service Functionality ...........ccccociiiiiiiiiiiiiiiiin, 188
Memory Requirements .............ccoooiiiiiiiiiiii 201
Communication with Other Applications ...........ccccevviiiiiiiiiiiiiiiiiiii 203
The Technical Information Function ...........c.cccccooeiiiiiiiii, 204
Layout MemDbeTrs .........cccouiiiiiiiiiiiiiiiiciicie e 204
Passwords and Cipher Code ............ccooviiiiiiiiiiiiiii 205
User Profile, Option and Adabas Password Hierarchies ..........c.c.cccceovieniinnnnnn. 205

Administration



vi



Preface

This documentation provides information on administrating Super Natural. The documentation
is organized in the following parts:

Introduction
Users

Files

Superfiles

User files
Libraries
Common library definitions
Special services
Batch processing
Batch utilities
Exit programs

Technical information
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

In addition, you can also access the cloud product documentation via https://www.software-
ag.cloud. Navigate to the desired product and then, depending on your solution, go to “Developer
Center”, “User Center” or “Documentation”.

Product Training

You can find helpful product training material on our Learning Portal at https://knowledge.soft-

wareag.com.
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About this Documentation

Tech Community

You can collaborate with Software AG experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:

® Browse through our vast knowledge base.

" Ask questions and find answers in our discussion forums.

Get the latest Software AG news and announcements.

Explore our communities.
® Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://hub.docker.com/publishers/softwareag and discover additional Software AG resources.

Product Support

Support for Software AG products is provided to licensed customers via our Empower Portal at
https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

® Download products, updates and fixes.

® Search the Knowledge Center for technical information and tips.

" Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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Introduction

This section introduces you to the Super Natural Administration Application.
This section covers the following topics:

® Administration Application Overview
® Administration Application User Interface

® Invoking the Super Natural Administration Application

Invoking the Super Natural Processor Application from the Administration Application

= Command Overview

Administration Application Overview

Super Natural administration is an independent application with its own command processor.
The users' part of Super Natural is called the Super Natural Processor.

The Super Natural Administration Application has three distinct sections as shown below:

Adrmin istratio nﬂ;;‘\

SUPER MATURAL
Uszers, Fles and Libraries

~—

MATURAL REFORT haANAGER

Layout Options and Standard Title

MATURAL

\-__ JoL Merrbers _/

® Super Natural
You use the main part of the Super Natural Administration Application to maintain users, files
(files, user files and superfiles) and libraries (public, common and private). The user interface
conforms with the Super Natural Processor application.

* Natural Report Manager
Parts of Natural Report Manager are incorporated. You can modify a user's layout options using
part of the Natural Report Manager Profile function. You can modify the Standard Title for your
site from the Special Services menu using the Layout Editor.
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® Natural
The Natural LIST command is incorporated. Choosing JCL Members from the Special Services
menu is the same as issuing the following Natural commands:

LOGON LIBRARY ZJCL

LIST *

Administration Application User Interface

The user interface for Super Natural uses menus, screens and windows.
Object List Screens

Instead of the Description column found in the Processor application, the object list screens in the
Administration Application have various information columns and do not have the Library and
Library Type fields as shown below:

Carrinand Colutrn
Marre Colurrn

r Start Value Field Infarmation Colurmng

/mss ‘ ‘ enmmn maE u;%cxxx . \

ST
.

Horm:

M _
CHE| x| A&, Hedify, Ospy, Inloto
Saloct ora comMand |from lizt

Qommand —==
Intor=Frle——Fri=—¥T 5= —FT 4= —F I ——FF 5= —FT Fme—FT 5= —FI 5= —=FF1 O—FT11 —=FT1 I ——
Halp Fxit nip + Sanc

.

L

—  Add Field

Legend
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> Navigation

The Modify Object screens and the Import Files Object list screen have > navigation fields for
navigating between groups of settings or object types in the bottom left-hand corner of the pro-
cessing area as in the sample below:

/13:55 ERZER SUFFR: MATURRL =xxzx 1353-0=-T1 \

- Hodify Uror AR =Optionz — FEHUHO

Huintonarco Suthorization o Ianguago # Frufimz
Fiznr  Mumborz - Uzor Tiloz

Tatamzo Focorz

Tatamzo Focorz and JOL

Tata HMairtonanco Tramzacten Type < Imta Saloctdsn
Fmpsrt Type 4 Fapsrt Iawal

Fapert Inztiratisn © Fun Hedo - Zatch Joh Entry

_ Trplay Optionx

~FT 4m—F IS == FF 5 =—FT Fm—e—FT 5w —F 5= —=FF1 O—FT11 —=FT1 I ——
niip Sanc

N Fhlavination Fields

~ To navigate between groups of settings or object types using > navigation

S

= Mark the appropriate > navigation field with the cursor position or any non-blank character
and press Enter.

Or:

Issue one of the following commands as appropriate:
" >OPTIONS

= >PROFILE

" D>USERS

= >PUBLIC

B >FILES

= >LAYOUT

" >PRIVATE

Note: For further information on using the new Super Natural user interface, see Using Super
Natural in the User’s Guide.
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Invoking the Super Natural Administration Application

~ To invoke the Super Natural Administration Application from a Super Natural session

s Select the function Super Natural Administration on the Processor Main Menu.
Or:
Issue the MAINTENANCE command from the Main Menu.

The Administration Menu appears:

Administration 9
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Invoking the Super Natural Processor Application from the Administration
Application

~ To invoke the Super Natural Processor application from the Administration Application

= Issue the PROCESSOR command.
The Super Natural Processor Main Menu appears.

You can use the PROCESSOR Super-Natural-command command to execute Super Natural
Processor commands directly from the Administration Application.

~ To execute a Super Natural Processor command directly from the Administration Application

m  Issue the PROCESSOR Super-Natural-command command.
The Super Natural Processor command is executed.

| Note: You return to the Administration Application via the Super Natural Menu.

Command Overview

User |File |Super File |User File [Lib. (U) (P) |Lib. Member |Lib. (C) |Standard Title |JCL Lib.
ADD X X X X X
MODIFY X X X

Ccory X X X X X
DELETE X X X

INFO X
IMPORT X
MULTIMOD |X X
MEMBER X
EDIT X
LIST
PRINT
RENAME
DISPLAY X
TEST X

<

X x| X X
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As users of this documentation should already be familiar with using Super Natural, only direct
commands are documented. For alternative methods of issuing commands, see Using Super Nat-
ural in the User’s Guide.

12 Administration
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Users

This section covers the following topics:

® What are Users?

® Default User *******

= User Profile

® Listing Users

® User IDs

® Adding Users

® Modifying Single Users

® Modifying Multiple Users
® Copying Users

® Deleting Users

® Importing Users

What are Users?

Each Super Natural user has a user ID and a user profile. User profiles consist of settings for options,
files, profile and layout. These settings influence the appearance of screens, and many technical
details concerning the environment, output and processing of transactions.

You can adapt the settings for each user of Super Natural to suit his or her individual requirements.
You can either use the settings in the default user profile ******* or change each setting individu-
ally. You can also change all users at once.

] Note: A user must be authorized to use at least one library.

You can perform the following commands on the object user:

ADD |MODIFY |COPY |DELETE |IMPORT [MULTIMOD
User | X X X X X X
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Default User *******

Software AG supplies a default user profile with the user ID ******* with Super Natural (known
as global options in previous versions). When you define a user, the default user profile of user
*xxxx+% s copied to the user ID you have specified.

You cannot delete the default user.
Modifying the Default User

You can modify the default user ******* supplied by Software AG to suit the needs at your site.

When you add or import the next user, any modifications you have made to the options and file
list of the default user are copied to the user ID you have specified. The standard profile and layout
settings provided by Software AG are always copied to new users created with the Add or Import
functions.

When you create a new user by copying the default user, any modifications you have made to the
default user's profile and layout are copied to the user ID you have specified in addition to the
modified options and file list.

User Profile

The Super Natural user profile settings are organized into four groups of equal status as shown
in the following diagram:

ADD
MODIF‘T’} USER
COPY

| Options Fies 4‘ Profile 4‘ Layout

Administration 15
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Listing Users

~ To obtain a list of users currently defined to Super Natural
= Issue the USER command.
Or:
Select the object User from the Administration Menu.

The User List screen appears:

16 Administration
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13:57 *xxx%% Super Natural ***** 1999-05-21
- User List - SNMUL
+
Cmd User ID Files Maintenance <
* o
| kkkkkRk 1 .
__ A 1 o
__ AA 1 ©
__ AAl 17 ©
__ AA2 17 ©
__ AA3 17 ©
__ AA4 18 o
__ AAS 17 ©
__ AA6 17 ©
__ AAY 17 ©
_ AAS8 16 ©
_ AA9 15 ©
__ AA91 16 ©
Add ©
Cmd(s): Add, Modify, Copy, Delete ©
Select one command from list ©
Command === ©
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF/---PF8---PF9---PF10--PF11--PF12---
Help Exit Canc <
The User List screen shows the following:
= List of the users defined to Super Natural.
® The number of files each user can access.
® Whether each user is authorized as an administrator.
Administration 17
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User IDs

Before you can add a user, you must decide which user ID to give him. The user IDs you can al-
locate depend on whether you are running Super Natural under Natural Security or not.

Super Natural with Natural Security

> To use Super Natural with Natural Security

»  Use the user's Natural Security logon ID.
You cannot override this.

| Note: If you import a user whose Natural Security logon ID is longer than 7 characters, it

is truncated.

Super Natural without Natural Security

~ To run Super Natural without Natural Security

m  Use the user's TP monitor user ID.
Or:
Use another ID of up to 7 non-blank characters.

In this case, a screen appears which asks you to enter an ID valid only for Super Natural. User
IDs created like this are not password-protected. Each time the user accesses Super Natural,
a logon screen appears where he must enter his Super Natural user ID.

Adding Users

> To add a user

m Issuethe ADD USER user-IDcommand.
Where user-10Dis the ID of the new user.

The default user ******* is copied to the user ID you specified and the Modify User >Options
screen appears. You can now modify the default user settings for the user you have created.
For further information, see Modifying Single Users.
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| Note: Natural Security users can also use the Import User function to define users to Super
Natural.

Modifying Single Users

~ To modify a user

m  Issue the MODIFY USER name command.

The Modify User >Options screen appears:

17:23 *xx%% Super Natural ***** 2000-06-16
POR - Modify User POR >Options - SRMUMO
Maintenance Authorization / Language / Prefixes

Sizes / Numbers / User Files

Database Access
Database Access and JCL

Data Maintenance Transaction Type / Data Selection
Report Type / Report Level
Report Destination / Run Mode / Batch Job Entry

Service Generation Options

Display Options

>Files >Profile >layout
Mark function(s) or select by cursor

Command ===
Enter=PFl=-==PF2===PF3===PFi===PF5===PFG===[PF7 == =PF@===PF9===PF10=-=PFll==PFl2===
Help Exit Flip Canc
4AR 22,015

You can either modify the user options or select one of the following setting groups using >
Navigation:

= File
" Profile
® Layout

Administration 19
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| Note: For information on navigating between profile setting groups, see Navigating Between
Profile Setting Groups.

~ To modify a user default setting

1 Overtype it.

2 Press Enter.

| Note: Users must restart their Super Natural sessions before your modifications are valid.

Your modifications are valid for all new transactions but not for existing ones.
Options
When you choose >0ptions, the Modify User >Options screen appears.

~ To modify user options

1 Mark the group(s) of options you want to modify.
2 Press Enter.

3 Opvertype existing entries as required.

4

Press Enter.
You can modify the following user options:

| Note: Options which the user can modify her or himself are marked with an asterisk (*) in
the following list.

Maintenance Authorization / Language / Prefixes

Option Description
Authorized for Y indicates that the user will be a Super Natural administrator. N indicates
Maintenance that the user will not be a Super Natural administrator. Default value = N.

Language Code*  Indicates the language to be used for error messages, text constants, screens,
help texts and commands. For example, 1 indicates English and 2 indicates
German Default value =1 . If Super Natural is available in one language
only, the Language Code setting in all user profiles must indicate this lan-
guage.

Private Library Prefix: Super Natural assigns a prefix to the ID of each private library. If you
leave the prefix blank, the user will have no private library and will be offered
a choice of the public or common libraries he is authorized to use when he
logs on to Super Natural. If he is not authorized to use any public libraries,
the user can choose which common library he wants to access. Default value
=Y. You cannot assign the same default prefix to private and public libraries.
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Option Description

Public Libraries Prefix: Super Natural assigns a prefix to the ID of each public library. If you
leave the prefix blank, the user will not be authorized to use public libraries.
Default value = Z.

Common Libraries Prefix: The common library prefix is assigned in SPPARM when Super Natural
isinstalled and cannot be modified here. Default value = C (non-modifiable).

Transaction Pro-  Prefix: Super Natural assigns a prefix to the ID of each transaction program.
grams Default value = I. Max. Numbers: The maximum number of transactions
permitted within a private library. Default value = 999.

Layouts Prefix: Each transaction has a layout member with the name layout-prefix
transaction-name. The layout member is in copy code. The layout prefix is
assigned in SPPARM when Super Natural is installed and cannot be modified
here. Default value = L (non-modifiable).

Prototype Programs Prefix: Super Natural assigns a prefix to the ID of each prototype program.
Default value = X. Max. Numbers: The maximum number of prototype
programs permitted within a user library. Default value = 35.

Application Pro-  Prefix: Super Natural assigns a prefix to the ID of each application program.

grams Default value = A. Max. Numbers: The maximum number of application
programs permitted within a user library. Default value = 35. Other Applic-
ations access If you leave the program prefix for applications blank, users
are not able to access Application Programs. Therefore there is no entry
Application Programs on the Menu.

Data Models Prefix: Super Natural assigns a prefix to the ID of each data model. Default
value = M. Max. Numbers: The maximum number of data models permitted
within a user library. Default value = 35.

Sizes / Numbers / User Files

Option Description

Online Screen Size* Determines the screen size to be used when producing reports using
Online Run mode. Depth: The number of lines. Default value = 24. The
depth may not exceed the physical screen size of the terminal. Width:
The width must exceed the display field length by at least 1.

Printer Page Size* Determines the page size to be used when producing reports using Run
Mode BATCH or Destination PRINTER. Depth: The number of lines. Default
value = 60. The depth may not exceed the physical page size of the batch
printer. Width: The number of characters per line. Minimum value = 80.
Maximum value = 250. Default value = 132. The width must exceed the
display field length by at least 1.

Logical Printer Num- Number of the printer to be used for report/logging destination PRINTER.
ber* There are separate settings for ONLINE and BATCH Run Mode.
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Option Description

Work File Number* Read: Work file number from which data is to be received in data selec-
tion mode WORK FILE. Write: Work file number to which data is to be
sent with report destination WORK FILE.

Personal Computer Read: Personal computer number from which data is to be received in
Number* data selection mode PC. Write: Personal computer number to which data
is to be sent with report destination PC.

User File Adabas Data- Database ID (DBID) of the physical Adabas file to be used as the Super

base ID Natural personal database for user files. For Natural Version 2.2 or Ver-
sion 2.3 under Adabas Version 5, the range is 0 - 254. For Natural Version
2.3 under Adabas Version 6 the range is 0 - 65535. Default value = zero.
Do not enter a database ID if you think you may want to change it in the
future. You cannot change the database ID for existing transactions!

User File Adabas File  File number (FNR) of the physical Adabas file to be used as the Super

Number Natural personal database for user files. For Natural Version 2.2 or Ver-
sion 2.3 under Adabas Version 5, the range is 1 - 255. For Natural Version
2.3 under Adabas Version 6 the range is 1 - 5000. The value zero indicates
that no user file is defined for the current user.

User File DDM Prefix ~ Super Natural assigns a prefix to the name of each file created by a user.
Default value = UF.

Maximum Number of The maximum number of user files permitted per user. Default value =
User Files 255.

User File Retention Time limit for user files in years, months and days. User files are deleted
Period when they have existed for the time specified in this option. Default value
=blank (no time limit defined).

Database Access
Option Description

Multi-File Transac- Y indicates that multiple-file transactions are allowed. N indicates that mul-
tion Allowed tiple-file transactions are not allowed. Default value = N.

Physical Read Al- Y indicates that a physical read of an entire file is allowed if required by the

lowed transaction's selection criteria in Online Run mode. N indicates that a physical
read of an entire file is not allowed. There are separate settings for Online
and Batch Run mode. Default value =Y. This option must be set to N for DL/
I files.

Non-Descriptor Y indicates that a transaction may use selection criteria that contain non-

Criteria Allowed descriptors, i.e., fields that have not been defined as key fields. N indicates
that the transaction may only use selection criteria comprised of key fields.
There are separate settings for Online and Batch Run mode. Default value =

Y.
Maximum Number The maximum number of criteria permitted within a transaction. There are
of Criteria separate settings for online and batch run mode. Default value = 99.
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Option

Description

Display Values For Y indicates that the user can use the Values for Key Fields functions which
Key Fields Allowed is available from the Information column of the Worksheet. N indicates that

Processing Se-
quence*

Flatten Repeating
Fields*

System Functions
per Outer Loop*

the user may not use the Values for Key Fields function. Default value = N.

Used to control the order in which the following are processed: File look-up
(F), Calculations (C), Logical conditions (L), inter-field Arithmetic (A), external
Sort (S) and Updating records (U) during transaction processing. Default se-
quence = FCLASU.

Specifies when the individual occurrences of multiple-valuefields or fields
contained in a periodic group should be presented as individual records when
changing data for a report or updating data. B indicates flattening before
processing: When you run a data maintenance or data change transaction
using this option, Super Natural displays a flattened version of the selected
data for editing. The occurrences of periodic groups are presented one at a
time as individual records which you can update or change. Once you have
updated or changed a record, you are shown how it will be output (still in
flattened form) before moving on to the next record. A indicates flattening
after processing (only available for data change): when you run a data main-
tenance or data change transaction using this option, Super Natural displays
a continuous list of the selected data for editing. All occurrences are numbered.
Once you have updated or changed a record, you are shown how it will be
output before moving on to the next record The data is flattened and each
occurrence is displayed as a separate record. blank indicates that no flattening
is to be performed: when you run a data maintenance or data change transac-
tion using this option, Super Natural displays a continuous list of the selected
data for editing as for flattening after processing. Once you have updated or
changed a record, you are shown how it will be output before moving on to
the next record. The data is not flattened. Default value = blank.

Before flattening
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Defines the evaluation of system functions used for control break processing
when two files have been linked for the transaction. Y indicates that system
functions are to be evaluated for all records found in the primary file (outer
loop). N indicates that system functions are to be evaluated for all records

found in the secondary file (inner loop). Default value = N. The above is only
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Option Description

relevant if two files are linked via the File Selection screen. If more than two
files are linked via the Lookup function (1:n), system functions are processed
per outer loop.

Adabas Sorting Al- Y indicates that the Adabas internal sort feature may be used for a transaction
lowed that contains sort criteria comprised of one to three key fields. N indicates
that the Adabas internal sort feature may not be used. Default value =Y. There

are separate settings for online and batch run mode. This option must be set
to N for DL/ I files.

Buffer/External Y indicates that a buffer or external sort feature may be used. N indicates that
Sorting Allowed  abulffer or external sort feature may not be used. Default value =Y. This option
allows separate settings for online and batch run mode.

Database Access and JCL
Option Description

DDM Checking on Y indicates that each time a Super Natural transaction is modified, a check

Modify is made to see if the transaction is still consistent with the data definition
module (DDM) for the file or files involved. A warning is issued when a
user modifies a transaction if the DDM has been changed. N indicates that
no check is to be made. Any changes made to the DDM since the transaction
was created/last modified are ignored. The default is N.

Maximum Number The maximum number of records that may be processed for a transaction.

of Records If you leave this setting blank, Super Natural will not enforce any limit on
the number of records processed. This option allows separate settings for
online and batch run mode. Default value = 999999. Users can reduce the
maximum number of records to be read for test purposes by changing the
transaction option Number of Records to be Read using the OPTIONS com-
mand for each transaction separately.

Maximum Report ~ The maximum number of pages permitted for a transaction report. This
Pages option allows separate settings for online and batch run mode. Default value
=9999.

Adabas Password  If an Adabas file which is security protected is to be available to Super
Natural transactions, the password for the file must be provided. See the
Adabas Security documentation for additional information on Adabas secur-
ity.

Adabas Cipher Code If an Adabas file which is ciphered is to be available to Super Natural
transactions, the cipher code for the file must be provided. See the Adabas
Security documentation for additional information on Adabas ciphering.

JCLID Any user-given name. By default, each JCL/JCS member is stored in the
library ZJCL. Default value = JCLO1.
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Transaction Mode Settings

The following groups of settings concern the user's transaction modes for data maintenance and

for reporting:

® Data Maintenance Transaction Type / Data Selection

Data Change / Report Type / Report Level
Report Destination / Run Mode / Batch Job Entry

> To authorize the user to use a mode

Enter Y next to the entry.

~ To prevent the user from using a transaction type

Enter N next to the transaction type entry.

~ To define the user's default for each group of transaction modes

Enter the corresponding character in the Default field.

Data Maintenance Transaction Type / Data Selection

Data Maintenance Transaction Type:

Note: The data maintenance functions are intended for use on user files only, not on produc-

tion or live data.

Transaction Mode Description

Reporting (I)
Add Records (A)

Allows the user to execute reporting transactions.

Allows the user to add records to a file (corporate file or user file) provided
the corresponding authorization level has been assigned for the file to be
used.

Update Records (U) Allows the user to update records in a file (corporate file or user file) provided

Delete Records (D)

Edit Data (E)

the corresponding authorization level has been assigned for the file to be
used.

Allows the user to delete records from a file (corporate file or user file)
provided the corresponding authorization level has been assigned for the
file to be used.

Allows the user to use the data editor for updating records. Default mode
setting = I.
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Data Selection:
Transaction Mode

Full-Screen (F)
SQL Select (S)

Description
The user can enter selection criteria using the Selection Editor.

Users of DB2 and SQL/DS can access the SQL SELECT Editor to write
SQL SELECT statements. Super Natural does not check whether Natural
DB2 is installed. If Natural DB2 is not installed, the user can still access
the SQL SELECT Editor and write SELECT statements. However, when
you CHECK, RUN or SAVE the transaction a Natural syntax error occurs
(even if the syntax would be correct for SQL).

Data from Work File (W) Allows the user to read data from a work file.
Data from PC File (P) Allows the user to read data from a PC file. Default mode setting = F.

Data Change/Report Type/Report Level

Report Data Change Mode
Transaction ModeDescription

Map (M)

None (N)

Report Type

The user can use an automatically generated map to change data for a report.
Data stored in the file or database is not affected by this change mode. For
example, the user can use this mode to modify data before sending it to a user
file or a printer.

Data may not be changed for a report. Default mode setting = N.

Transaction ModeDescription

List (L)

Vertical List (V)
Table (T)
CON-NECT (C)

Report Level

Report data is displayed with a title (optional) and column headers.
The report is displayed vertically (one or more pages per record).
The report is displayed in tabular form.

The report is processed by Con-nect. Default mode setting = L.

Transaction ModeDescription

Detail (D)
Summary (S)

Y indicates that all output is desired.

Y indicates that only the information that results from a control break is shown
in the report. If no system functions are defined at control breaks, the records
found are counted. Default mode setting = D.
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Logging

Transaction Mode Description

Data Maintenance  The logging mode for data maintenance transactions can be set to the fol-

Logging

lowing values:

Y indicates that the logging option for data maintenance transactions is
enabled and set to to the default value Y.

N indicates that the logging option for data maintenance transactions is
enabled and set to the default value N.

P indicates that the logging option for data maintenance transactions is
disabled and no logging can be specified by the user.

F indicates that the logging option for data maintenance transactions is al-
ways performed.

Report Destination / Run Mode / Batch Job entry

Report/Logging Destination
Transaction ModeDescription

Screen (S5)
Printer (P)

Editor (E)

Work File (W)

PC File (F)

User File (U)

Display on the user's screen.

Report data is routed to a printer. Output may be routed to a printer only if
Com-plete or Natural Advanced Facilities is installed at the user site. Output
may be routed to a PC only if Entire Connection is installed at the user site.

Report data is written to a Natural editor source program work area. Once the
output has been placed in the source program work area, the Natural editor is
invoked and may then be used to edit and, if desired, to save the outputin a
Natural library. Y indicates that destination EDITOR is available. N indicates
that destination EDITOR is not available. Default mode = N. If the EDITOR
option is disabled, the user may not generate prototype programs.

Report data is written to a Natural work file. If any setting other than N is
entered, a number that represents the logical identification of the sequential
work file must be defined as described in the section Setting Global Options.
Be sure to check whether your environment supports the use of work files. See
the Natural documentation for further information on the usage and assignment
of sequential work files.

Report data is transferred to a Personal Computer (PC). If any setting other
than N is entered, a number that represents the logical identification of the
personal computer must be defined as described in the section Setting Global
Options. This feature is only supported if Entire Connection is installed at the
user site. The connection between the host and the PC must be activated by
entering %+.

The transaction data is written to a user file, that will be generated automatically
during transaction execution. The use of the user file feature is only supported
if Adabas is installed at the user site.
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Transaction ModeDescription

CON-NECT (C) The report is written as a document to a Connect system folder where it can be

Run Mode

processed using Con-nect. The use of this feature is only supported if Con-nect
is installed at the user site. Default mode setting = S.

Transaction ModeDescription

Online (O)

Batch (B)

Batch Job Entry

ONLINE run mode permits the creation and execution of transactions from an
online terminal. Y indicates that online mode is available. N indicates that
online mode is not available. The default is Y.

BATCH run mode may be used to submit a transaction for execution in batch
mode using a remote job entry facility. Y indicates that batch mode is available.
N indicates that batch mode is not available. Default mode setting =Y.

Transaction ModeDescription

RJE available

Super Natural transactions may be submitted for batch mode execution if the
Natural RJE facility is available at the user site. Y indicates that remote job
entry is available. N indicates that remote job entry is not available, i.e. a
transaction for batch execution may be created but not submitted. Default
mode setting = N.

Service Generation Options

Option
Service Type

Generation Mode

Library Type for
Service Objects

Description

Here you can define which service generation is allowed:
N No service generation is allowed.
R RPC Service is allowed.

Here you can define which generation mode is used.

C Context: A context area is defined where all data is stored. The client reads
the data side by side. Thereby the 30K limit can be exceeded.

D Direct: All data sets are read out directly. If there are more result sets than
the 30K limit allows, you receive a hint for the further data

Defines in which kind of library the service objects are stored.

S Super Natural Library: The service object is stored in the same library as
the transaction and receives the same name as the transaction but with the
prefix defined for prototyping. It is not necessary to fill in the field Library
Name.

N Specific Natural Library: You have to specify the library name (in the field
Library Name for type N)where the service objects are stored. Here, the
service object name and the transaction name are identical.

F Free: The user can choose the library and object name without any restric-
tions.
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| Note: Setting the library type is important to meet the requirements of the RPC logon feature
that is set on the client side. For further information see section Create Client Side Paramet-

ers.

Display Options

Option Description

Display Occurrences Here you can define which range of occurrences is to be displayed for

MU)* a field defined as a multiple-value field. You can define a start value
and an end value. Default value = 1.

Display Occurrences The default number of occurrences to be displayed for a field contained

(PE)* within a periodic group. You can define a start value and an end value.

Default value =1.

Suppress Empty Lines* Y indicates that each empty line on a transaction report is to be sup-
pressed. N indicates that empty lines are not to be suppressed. Default
value = N.

Suppress Identical Val- Y indicates that each identical line on a transaction report is to be sup-
ues* pressed. N indicates that identical lines are not to be suppressed. Default
value = N.

Suppress Zero Values® Y indicates that a value of zero for a field is to be suppressed on the
transaction report. N indicates that zero values are not to be suppressed.
Default value = N.

Suppress Numeric Sign* Y indicates that the sign of a numeric field is to be suppressed on the
transaction report. N indicates that the signs of numeric fields are not
to be suppressed. Default value = N.

Heading Width Over- Y indicates that Super Natural may truncate headers on the transaction

ride* report if it is necessary to do so in order to prevent a line overflow
condition. N indicates that header truncation may not be performed. If
N is specified, a screen appears when the headers are too long where
the action to be taken can be entered. Default value = N.

Map Filling Character* Characters chosen to differentiate between alphanumeric and numeric
fields in transactions generated for adding or updating data or for re-
porting using the Data Change mode MAP. Default value for alphanu-
meric fields = _ (underscore). Default value for numeric fields = . (peri-
od).
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Files

When you choose >Files, the Modify User >Files screen appears:

13:59 xA%FKk Super Natural **xxxx 1999-05-21
- Modify User SBE >Files - SRMUMF
More: = aF
Cmd File Name Access Password
*
SAG-TOURS-E-CH-PRICES
SAG-TOURS-E-COMPANY
SAG-TOURS-E-CONTRACT
SAG-TOURS-E-CRUISE
SAG-TOURS-E-PERSON
SAG-TOURS-E-YACHT
SUE-SUPER
SUE1
SUPER
UF-SBE-NEW
_ UF-SBE-SAMPLE4 F
Add Add Multiple: _

m o O O X Xxo o O o X0

<

>Options >Profile >layout

Cmd(s): Add, Modify, Delete

File deleted from file list

Command ===

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF/---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip A Canc

The Modify User Files screen displays the following:

= Files which the user can access
= Code for the data access level the user has for each file
® Whether the user has an Adabas password for password protected files.

You use the Modify User >Files screen to link a user to (give him/her authorization to use) a file
or to modify or delete existing links.
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Adding / Linking Single Files to a User

~ To add (link) a single file to a user

1

Issue the ADD file-name command.

where fi7e-name is the name of a file defined to Super Natural.
To obtain a selection list of files defined to Super Natural, use the Add Multiple File function.

The Add/Modify Link to File window appears:

/1::59 AXEEE FUPTR HATURRL RRRER 18550521 \

- Hodify Umar SET -Tilox - FRHHT

¢
B
i
1
F
I
|
1
|
i
]
|
1
&
B
B
H
i
3
[
B
¢
i

B4

SAG-TOUE ! Tilo sarm ..... SRG-TOURS-Z-COWTRRAIT____
SRG-TOUR !

SRG-TOUR ! Fccorz ........ B

SRG-TOUR !

SAG-TOUR ! FazzvsTd Ink ..

SAG-TOUR ! FazzusTd ...,

SUE-SUFE !
UEL

[ T O I I

Determine the user's access level to the file by typing one of the following codes in the Access
field:

File Access Code |Description

R Read only

U Update (includes read). The user can update existing records in this file. Not available
under Natural Security.

A Add (includes update). The user can add new records to this file. Not available under
Natural Security.

Delete (includes add). The user can delete records in this file.

F If an F is entered in the Access field, the file is a user file created by the user you are
modifying. All data maintenance functions are available (read, add, update and
delete). For further information on user files, see User Files.

Enter a password in the Password field (optional).

Users who do not have the same password cannot access transactions in public or common
libraries created by this user using this file.

For further information on passwords, see User Profile, Option and Adabas Password
Hierarchies in Technical Information.

Press Enter.

The user is now authorized to use the file at the access level specified.
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Adding / Linking Multiple Files to a User

> To link multiple files to a user

Mark the Add Multiple Files field on the Modify User >File screen.

The Add Multiple Files window appears:

/14:0; REEEE SUPER HATURRL =Rx=x 155T-0T-21 \

- Hodify Umar SET -Tilox - FRHHT

¢
14

Fil tom—m e RAACTATE Hultiplo Flore——————e— e
Tilo Hamo Fccorr  Farzuord !

SRG ! $OOHMEST _
FI-TILE _
RA-SUFER _
40 o
ARRRARAAR _
RRARARAL _
RARL _

HERNREREERN
5
1]

| DN N I (R DO N N N A B B

=optionz  ~Frofilo
Sud|z|: B, Hedify, *Hom!
Hazk filor for function RBD HULTIPLE

Sommand —==
Intar=FTlem—FF 2= —FII=——FF4=—FI T e —FT &= —FI === FI T =—FT §=m —FF1 0 —FT1l —=—FT1 I
Halp Txit nip + Sanc

- S/

Mark each file you want to the user to be able to use.

Type in a file access code for each file.

For further information on file access codes, see Adding / Linking Single Files to a User in
Users.

Type in a password for each file (optional).

Press Enter.

The user is now authorized to use the files at the access levels specified.

Modifying Links to Files

You can modify the access code and Adabas password for files the user is already authorized to

use.

~ To modify entries in the file list

1

2

Issue the MODIFY file-name command.

The Add/Modify Link to File window appears.
Modify the file access code (optional).
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If the Password Set field is marked, a password is already defined for the file. You can either
change or delete the password.

3  Type anew password in the Password field to change the current password (optional).
Or:
Type blanks in the Password field to delete the current password (optional) and press Enter.

The user is now authorized to use the file at the access level specified.
Deleting Links to Files

You can delete the link from a user to a file, the access code and Adabas password for files the
user is already authorized to use.

> To delete a file from the file list

1 Issuethe DELETE file-name command.

2 Confirm the deletion in the window which appears.

The user is no longer authorized to the file named.
Profile

When you choose >Profile the Modify User >Profile screen appears:

Administration 33



Users

14:02 FxFx*% Syper Natural ***** 1999=0%=21
- Modify User SBE >Profile - SRMUMP

Screen Colors
Screen Defaults
Date/Time Formats
PF-Key Settings

Checklist

>Options >Files >Layout
Mark function(s) or select by cursor

Command ===
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip Canc

The User >Profile screen is a reduced version of the Modify Profile screen in the Super Natural
Processor.

Screen Colors *

Determines the user's default screen colors. On the left-hand side of the Screen Colors window
there is a list of the field types and screen areas which can be colored individually with their current
color code settings. The right-hand side shows a list of the colors available with their color codes.

If you mark the Mark for Default field and press Enter, you return to the default settings supplied
by Software AG.

Screen Defaults *

Message Line Position
Determines the message line position. There are three choices:

® ISA (above the command line)
® TOP (at top of the screen)
® BOT (at bottom of the screen)
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Header Line Variables

Determines the position of the date, time, program name, object and day within the Super Natural
header.

Hello Screen

The Hello screen is the screen which welcomes you to Super Natural. You can choose to switch
this screen off.

Default Entry Menu

Determines which of the following screens appears after the Hello screen when the user enters
Super Natural:

" Main Menu

" Transaction List screen

" Prototype Program List screen
® Model List screen

" Spreadsheet List screen

" Application List screen

= User File List screen.
Time and Date Formats *

Time Format

Determines how the date and time are displayed. You can choose to display the time either in 24
hour format e.g. 17.30 or in am/pm format e.g. 5.30 pm.

Time Delimiter

Determines the time delimiter (the character which comes between the hours and the minutes
when a time is written). You can choose which character you want to use as the time delimiter.

Date Format

Determines how the date is displayed. You can choose to display the date in any format you wish.
The following are some examples of dates in different formats and with different delimiters:
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American MM/DD/YY
European DD/MM/YY
German DD.MM.YY
International |YY-MM-DD
Date in format|YYYYMMDD

PF Key Settings *

Determines the PF key display format. You can choose between ISA format, SAA format and action
bar format.

Checklist *

Determines whether the user is to use the Automatic Checklist function by default and at which
level.

Layout

When you choose >Layout, the Profile Menu appears. You are now using the Modify User Profile
user-1id part of the product Natural Report Manager.

| Note: You cannot issue the PROC command from Natural Report Manager.

~ To specify the Layout

1 Mark Layout Options.

2 Press Enter.

The Layout Options: Screen Handling screen appears as in the following example:
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14:03 *** Natural REPORT MANAGER *** 1999-05=21

Layout - Modify User Profile SBE - NRMPROA
More: +

Layout Options: Screen Handling ©

-

Layout overview as default .................... X <

o

Layout element literals on right side ......... X ©

o

Layout Element Sorting (Choose one) ©

No sorting decided ........ ..., _ ©

Manual sorting via command .................. _ ©

Automatic sorting after every modification .. X ©

-

Layout Editor Screen State (Choose one) ©

Full screen without PF-Keys ................. _ <

Full screen with PF-Keys ... ... X ©

o

o

o

You are on the first page. ©

Command === ©

Ent@r=PFl===PF2===PF3===PFl===PF5===PFG===P[F7 ===PFE===PFY===PFLlO==PFL1l==PF12===
Help Exit Flip + Tech Canc <

You can modify the following options:

Option Description

Layout overview as de- If you mark this field, the Layout Overview screen is the first screen
fault the user will see when he invokes Natural Report Manager. If you
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Option Description

leave this field blank, the Layout Editor (split screen) appears with
all elements in the edit area.

Layout element literals If you mark this field, layout element literals (the Type column)

on right side appear on the right-hand side of the Layout Editor edit area. If
you leave this field blank, layout element literals (the Type column)
appear on the left-hand side of the Layout Editor edit area.

Layout Element Sorting

~ To specify the Layout Element Sorting

= Mark one of the following options:
Option Description

No sorting decided Layout elements are shown in the Layout Editor in the order
they were defined. The elements appear in logical order when
the report is run.

Manual sorting via command The user can issue the SORT command to sort layout elements
into logical order in the Layout Editor.

Automatic sorting after every Layout elements are sorted into logical order in the Layout
modification Editor when the user presses Enter. Default value: Automatic
sorting.

Layout Editor Screen State

~ To specify the Layout Editor Screen State

= Mark one of the following options:
Option Description

Full screen without PF keys When the user invokes the Layout Editor full screen, the PF key
line is replaced by two extra editor lines.

Full screen with PF keys ~ When the user invokes the Layout Editor full screen, the Pr key
line is displayed. Default value: Full screen with PF keys.

Delimiter

When you page forwards, the following screen appears:
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14:03 **% Natural REPORT MANAGER *** 1999-05-21
Layout - Modify User Profile SBE - NRMPROC

More: =
Layout Options: Delimiter

Class Attribut Color Delimiter
Text__ Default_ Blank
Text Intens._ _
Output__  Default_ (
Qutput__  Intens._ )

You are on the last page.

Command ===
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip - Tech Canc

You can create delimiters for the user to use in the Layout Editor using the following columns.
Column Description

Class The following classes are available: Text and Output Only.

Attribute The following attributes are available: Italic/Cursive Normal (default), Intensified, Not
displayed (for passwords etc.), Underlined, Reverse video, Dynamic (not available).

Color The following colors are available: Blue, Green, Neutral, Pink, Red, Turquoise, Yellow.

Delimiter Use special characters as delimiters to represent the combinations of class, attribute
and colors you have specified.

Modifying Multiple Users

The Modify Multiple Users function is available from the Special Services menu. For further in-
formation, see Modifying Multiple Users in Special Services.
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Copying Users

~ To copy a user

n Issue the COPY USER source-user-id target-user-idcommand.

A new user is created with the general options, file list, profile options and layout options of
the source user.

Deleting Users

> To delete a user

1 Issuethe DELETE USER user-idcommand.

2 Confirm the deletion in the window which appears.

Importing Users

When Super Natural is operating under the Natural Security system, you can use the Import User
function instead of the Add User function to define users.

The Import User function is listed on the Special Services menu. For further information, see Im-
porting Users in Special Services.
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This section describes how to create and maintain file profiles.

This section covers the following topics:

® What are File Profiles?
® Listing File Profiles
® Adding Files

® Modifying Single Files

® Copying Files

® Deleting Files

® Importing Files

What are File Profiles?

File profiles consist of file option settings and a list of the users authorized to use the file.

You can add file profiles to Super Natural before the corresponding DDM or file in the database
exists or is linked toSuper Natural.

RADDIFY File

Options

Usars

For further information on option hierarchy, see User Profile, Option and Adabas Password
Hierarchies in Technical Information.

You can perform the following commands on file profiles:

ADD

MODIFY

COPY

DELETE

INFO

IMPORT

MULTIMOD

File

X

X

X

X

X
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File Lists

The File List in the Administration Application lists all the file profiles defined in Super Natural.
No checks are carried out to determine whether the Natural files and DDMs exist or not. All other
lists of files which you can invoke in the Super Natural Administration Application and the Super
Natural PROCESSOR are subsets of this list. In some cases, only files which fulfil certain conditions
are displayed. The following diagram shows in which cases validity checks are carried out before
a list of files is displayed:

SUPER MATURAL Adrministration Application
Fie List
hedinid ifiy Lser Super- UserFie
RN Fies fie List List
Fiz Se- UsarFie
lection List List
SUPER MATURAL Processor

[] =List checked before display

The following table describes which checks are carried out:
List Administration Applica-Files Displayed/Checks Performed Before Display
tion

File List All files, superfiles and user files defined in Super Natural (no
checks).

Superfile List All superfiles defined to Super Natural (no checks).

Modify User xxx >Files All files, superfiles and user files added to the Super Natural user
specified (no checks).

User File List All user files which are defined in the current Personal Database.

Super Natural checks that there is a corresponding DDM for each
user file in the current FDIC. Super Natural also checks that the
directory record for each user file exists.
List Super Natural Processor Files Displayed/Checks Performed Before Display
User File List All the user's own user files (file access code F). Super Natural
checks that the directory record for each user file exists.
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List Super Natural Processor Files Displayed/Checks Performed Before Display

File Selection List for Reporting 1. All the user's own user files (file access code F) (no checks).
Transactions: 2. All files and other user's user files with file access codes R,
A, Uand D (no checks).
3. All superfiles based on reporting transactions. Super Natural
checks that the superfile transaction exists.

File Selection List for Data Mainten- 1. All the user's own user files (file access code F) (no checks).
ance Transactions: Transaction 2. All files and other user's user files with file access codes A
Type ADD: and D.
3. All superfiles based on data maintenance transactions with
Transaction Type ADD.

File Selection List for Data Mainten- 1. All the user's own user files (file access code F) (no UPDATE

ance Transactions: Transaction ~ checks).

Types SINGLE/UPDATE MULTIPLE 2. All files and other user's user files with file access codes A,
U and D.
3. All superfiles based on data maintenance transactions with
Transaction Type UPDATE SINGLE or UPDATE MULTIPLE.

File Selection List for Data Mainten- 1. All the user's own user files (file access code F).

ance Transactions: Transaction 2. All files and other user's user files with file access codes D.

Type DELETE 3. All superfiles based on data maintenance transactions with
Transaction Type DELETE.

Listing File Profiles

~ To obtain a list of files currently defined to Super Natural
m  Issue the FILE command.
Or:
Select the object Fi1e from the Administration Menu.

The File List screen appears as in the following example:
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14:31 *FxAx% Super Natural ***** 1999-05-21
SBE - File List - SNMFL
More: +

Cmd File Name File Type ©

* ©

__ $CONNECT ©

_ A-U-FILE ©

__ AA-SUPER Superfile ©

__ AAA Superfile ©

__ AAAAAAAAA ©

__ AAAAAAAL Superfile ©

_ AAAL -

_ AAl -

__ AA2 -

__ AA8 o

__AA9 ©

__ ACTIVE-JOBS e

_ ADMINISTRATION-FILE-DDM ©

Add ©

Cmd(s): Add, Modify, Copy, Delete ©
Select one command from list ©
Command === ©

Enter=PFl===PF2===PF3===PFi===PF5===PFe===PF7 == =PFE===PF9===PF10=-=PFLl==PFl2==-
Help Exit Flip + Canc «

The File List screen shows the following;:
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= All files currently defined to Super Natural including DDMs, user files and superfiles.
The DDMs and the files on which they are based are not necessarily defined either in the
database or to Natural Security. Super Natural does not check this until a user adds a
transaction using the file.

* File type.
User files and superfiles are indicated in the File Type column.

Adding Files

> To add a file

m  Issue the ADD FILE name command.
You cannot add superfiles and user files.
The file is added (linked) to Super Natural. The Modify File > Options screen appears.

You can now set options and authorize users to use the file you have added. For further information,
see Modifying Single Files in Files.

] Notes:

1. When you add (link) a file to Super Natural, the file has no option settings and no user list. If
you leave the options settings and/or the user list blank, the individual file settings which are
part of each user profile are valid for users when accessing this file. Otherwise, options set for
a file in its file profile override options set for it in a user profile. For further information on
option hierarchy, see User Profile, Option and Adabas Password Hierarchies in Technical In-
formation.

2. When you have finished modifying the file options and users, the file is added to the File List.

3. The DDM and the file on which it is based are not necessarily defined either in the database or

to Natural Security.Super Natural does not check this until a user adds a transaction using the
file.

4. Users of Natural Security can also use the Import function to define file profiles.
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Modifying Single Files

~ To modify a single file
m  Issue the MODIFY FILE name command.

The Modity File >Options screen appears. You can either modify the file options or modify
the user list.

For information on navigating between profile setting groups, see > Navigation in Introduction.

| Note: Users must restart their Super Natural sessions before your modifications are valid.

Your modifications are valid for all new transactions but not for existing ones.
Options

| Note: File options override user options. For further information on option hierarchy, see

User Profile, Option and Adabas Password Hierarchies in Technical Information.

~ To specify Options
1  Choose >0Options.

The Modify File >Options screen appears.
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14:32 st Super Natuipgl s 1999-05-21
SBE Modify File SAG-TOURS-E-CONTRACT >Options SRMFMO

«

DDM Check / Display Options <

Database Access ©

Exit Specification ©

VSAM Files ©

DL/1 Files ©

>Users o
Mark function(s) or select by cursor ©
Command === ©

Enter=PFl===PF2===PF3===PFl===PF5===PFE===PF/===PF8===PFY===PFLO=-=PFLLl==PFl12===
Help Exit Flip Canc <

2 Mark the group(s) of options you want to modify and press Enter.
3 Opvertype the options you want to modify if you are modifying a file.

Or:
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Type settings if you are adding a file and press Enter.
You modifications/entries are saved.

You can modify the options listed in the following sections.

DDM Check / Display Options
Option Description

DDM Check on Modify Y indicates that each time a Super Natural-transaction is modified, a
check is made to see if the transaction is still consistent with the data
definition module (DDM) for the file or files involved. A warning is
issued when a user modifies a transaction if the DDM has been
changed.

N indicates that no check is to be made. Any changes made to the
DDM since the transaction was created/last modified are ignored.

The default is N.
Prefix for Inverse Field Prefix used for files with both fields in regular and inverse format.
Output See Super Natural in Inverse Mode in the Setting up Super Natural docu-

mentation. The default value is blank.

Display Occurrences (Mul- The default number of occurrences (i.e. values) that are to be displayed
tiple Value Field) for a field defined as a multiple value field. The default setting is 1.

Display Occurrences (Peri- The default number of occurrences that are to be displayed for a field
odic Group) contained within a periodic group. The default setting is 1.

Suppress Numeric Sign Y indicates that the sign of a numeric field is to be suppressed on the
transaction report.
N indicates that the signs of numeric fields are not to be suppressed.
The default setting is N.

Run Modes Available ONLINE run mode allows users to access the file online.
BATCH run mode allows users to access the file in batch operation.

Database Access
Option Description

Physical Read Allowed Y indicates that a physical read of an entire file is allowed in the case of
a transaction in which the selection criteria specified requires such.
N indicates that a physical read of an entire file is not allowed. The de-
fault setting is Y. This option allows separate settings for online and
batch run mode. This option must be N for DL/I files.

Non-Descriptor Criteria Y indicates that a transaction may use selection criteria that contain non-
Allowed descriptors, i.e., fields that have not been defined as key fields.
N indicates that the transaction may only use selection criteria comprised
of key fields. The default setting is Y. This option allows separate settings
for online and batch run mode.
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Option Description

Maximum Number of The maximum number of criteria permitted within a transaction. The

Criteria default setting is 99. This option allows separate settings for online and
batch run mode.

Display Values For Key Y indicates that users can use the Values for Key Fields function on this
Fields Allowed file.
N indicates that the user may not use the Values for Key Fields function.
Default value = N.

Adabas Sorting Allowed Y indicates that theAdabas internal sort feature may be used for a
transaction that contains sort criteria comprised of one to three key fields.
N indicates that theAdabas internal sort feature may not be used. The
default setting is Y. This option allows separate settings for online and
batch run mode. This option must be N for DL/ Ifiles.

Buffer/External Sorting Y indicates that a buffer or external sort feature may be used.

Allowed N indicates that a buffer or external sort feature may not be used. The
default setting is Y. This option allows separate settings for online and
batch run mode.

Maximum Number of = The maximum number of records that may be processed for a transaction.
Records The default setting is 999999. This option allows separate settings for
online and batch run mode.

Adabas Password If an Adabas file that is security protected is to be available to Super
Natural transactions, the password for the file must be provided. See
the Adabas Security documentation for additional information on Adabas
security.

Adabas Cipher Code  If anAdabas file that is ciphered is to be available to Super Natural
transactions, the cipher code for the file must be provided. See the Adabas
Security documentation for additional information on Adabas ciphering.

Exit Specification

Option Description

Exit Module Program ID Specify the name of the external program to be activated. The program
must be accessible via a Natural CALL or CALLNAT statement.

Use Natural Object Mark this field if the user exit program is a Natural object.

Exit Location Defines when the exit routine is to be executed. The available options
are listed on the screen. Enter the appropriate number.

The exit module specifications made as file options are used as default values when the file is ac-
cessed. Users can override the default values using the Exit Specification function described in
the section User Exits in the User’s Guide.

Note: If the exit program requires parameters, the user must specify them manually using

the Exit Specification function.
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For further information on user exits, see Exit Programs.
VSAM Files

Note: You cannot use the transaction mode for data maintenance UPDATE MULTIPLE with
VSAM files.

Option Description
Record Type Field Name Name of the field on which the record type is based.

Record Type Format Format of the record type.A - alphanumeric, N - numeric,B - binary.
Record Type Length Length of the record type (1 to 10).

Record Type Offset Number of positions in the record type base field prior to the record
type value. For example, if the record type being defined is located in
the third position of the base field, the value 2 would be entered as
offset to skip the first two positions.

Record Type Value Value of the record type.

Record Type End Value End value, if the record type is to cover a range of values (optional).

Example:

Record type field name CRUISE-ID
Is record type a key?

Record type format N

Record type length 1

Record type offset 1

Record type value 3

Record type end value 5

If a transaction is created using the user view as defined above, only those records of the physical
file will be available that have the numbers 3, 4 or 5 (value/end value) as second character (offset)
of the field CRUISE-ID.

DL/l File Options (DL/I Considerations)

Note: The file options Physical Read Allowed and Adabas Sorting Allowed must be set
to N for DL/I files.

The following window is displayed:
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14:32 s SUpEr Naturel s 1999-05-21
SBE Modify File SAG-TOURS-E-CONTRACT >Options SRMFMO
LR DL/1 Files--------------- +

File: SAG-TOURS-E-CONTRACT

DDM Check / Display 0 !
Enter up to 5 PSBs where this file is

_  Database Access included.
_ 1.
2 .
_ VSAM Files 3.
4 .
DL/1 Files 5 -

|
|
|
|
|
|

Exit Specification !
|
|
|
|
|
I (DL/1 only)
|

The PSB entry is used for the NATPSB command when running a transaction against a DL/1 file.
If only one file is accessed in the transaction, the first PSB entry will always be used.

If two files have been linked for the transaction, the PSB lists of these files are compared to find a
common PSB for the linked files.

Note: This option is only valid when operating under CICS.

Users

When you choose >Users, the Modify File >Users screen appears as in the following example:
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14:33 FHxx*%x Syper Natural ***** 1999-05-21
SBE - Modify File SAG-TOURS-E-CONTRACT >Users - SRMFMU
More: 4
Cmd User ID Access Password
*
AZ
BF
CCA
CCH
CF
CHEF
CMR
CR
DA
DEMO1
__ DEMO2 R
Add Add Multiple: _

o X0 o O OO O X o O X

>Options
Cmd(s): Add, Modify, Delete
Select one command from Tist
Command ===
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF/7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc
The Modify File >Users screen displays the following information:

® Users which are authorized to use the file you are modifying.
= Code for the data access level the user has for each file.

® Whether the user has an Adabas password for password protected files.

You use the Modify File >Users screen to link users to (give him/her authorization to use) to the
file you are modifying/adding or to modify or delete existing links.

If you are adding a file, the Modify File >Users screen is empty.

Adding / Linking Single Users to a File

> To add (link) a user to a file

1 Issue the ADD USER name command.

The Add/Modify Link to User window appears:
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14:34 *FxAF* Syuper Natural ***x** 1999-05-21
SBE - Modify File SAG-TOURS-E-CONTRACT >Users - SRMFMU
<«
Cmd User ID Access Password +--Add/Modify Link to User--+
* [ P

!
_ Az R ' User ID ....... CF !
__ BF R ! ©

|
__ CCA R I Access ........ D ©

!
__ CCH R ! ©

!
mo CF D I Password set .. ©

!
_ CHEF D ! Password ...... !
__ CMR D ! ©

|
CR R fecccscc=ssccscsscsc=s=c=s=== +H

Determine the user's access level to the file by typing one of the following codes in the Access
field:

File Access Code |Description

R Read only

U Update (includes read). The user can update existing records in this file. Not available
under Natural Security.

A Add (includes update). The user can add new records to this file. Not available under
Natural Security.

D Delete (includes add). The user can delete records in this file.

Enter a password in the Password field (optional).

Users who do not have the same password cannot access transactions in public or common
libraries created by this user using this file.

Press Enter.
The user is now authorized to use the file at the access level specified.

For further information on passwords, see User Profile, Option and Adabas Password Hier-
archies in Technical Information.
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Adding / Linking Multiple Users to a File

~ To link multiple users to a file

1  Mark the Add Multiple field on the Modify File >User screen.

The Add/Link Multiple Users window appears:

14:34 R SUper Natural === 1999-05-21
SBE - Modify File SAG-TOURS-E-CONTRACT >Users - SRMFMU
«

Cmd User ID Access Password +----Add/Link Multiple Users----+

ud ! User ID Access Password !

__ AZ R ! e ©
|

i BF R | *kkkkKk*k l

__ CCA R A _ !

__ CCH R I AA _ !

__ CF D I AAl _ !

__ CHEF D I AA2 _ !

__ CMR D I AA3 _ !

__ CR R I AA4 _ !

__ DA R I AAS _ !

__ DEMOIL R I AA6 _ !

__ DEMO2 R ' AA7 _ !

Add Add Multiple: x I AA8 _ !

I AA9 _ !

>Options ! ©
|

Cmd(s): Add, Modify, Delete +More:  tH----------o-o--------- +

2 Mark each user you want to use the file.

3  Typein a file access code for each user.
For further information on file access codes, see Adding / Linking Single Users to a File in
Users.

4  Typein a password for each file (optional).

5  Press Enter.

The users are now authorized to use the file at the access levels specified.
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Modifying Links to Users

You can modify the access code and Adabas password for users already authorized to use the file.

> To modify a link to a user

1 Issuethe MODIFY wusercommand.

The Add/Modify Link to User window appears.
2 Modity the file access code (optional).

If the Password Set field is marked, a password is already defined for the file. You can either
change or delete the password.

3  Type anew password in the Password field to change the current password (optional).
Or:
Type blanks in the Password field to delete the current password (optional) and press Enter.

The user is now authorized to use the file at the access level specified.
Deleting Links to Users

You can delete the link from the file to a user, the access code and Adabas password for files the
user is already authorized to use.

> To delete a file from the file list

1 Issuethe DELETE user-id command.

2 Confirm the deletion in the window which appears.

The user named is no longer authorized to the file.

Copying Files

~ To copy a file

(] Issue the COPY FILE source file-name target file-name command.

A new file is created with the file options and user list of the source file.
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Deleting Files

> To delete a file

1 Issuethe DELETE FILE f7ile-name command.

2 Confirm the deletion in the window which appears.

Importing Files

When Super Natural is operating under the Natural Security system, you can use the Import File
function instead of the Add File function to define files.

The Import File function is listed on the Special Services menu. For further information, see Irm-
porting Files in Special Services.
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This section covers the following topics:

® What are Superfiles?

® What are Superfile Profiles?
® Listing Superfiles

® Adding Superfiles

" Modifying Superfiles

® Deleting Superfiles

What are Superfiles?

Superfiles are transactions stored as files. Superfiles are transactions created by the administrator
which the user can access from the Superfile Selection List window.

Superfiles reside in a Super Natural library. The name of this library is composed of the prefix for
public libraries in the administrator's user profile (default Z) together with the text string SUPFILE:
administrator's-public-Tibrary- prefixSUPFILE

| Note: Only users which have the same public library prefix as the administrator can use
superfiles.

You can use the following commands with the object Superfile:

ADD |MODIFY |COPY |DELETE |INFO [IMPORT |MULTIMOD
Superfile |X X X X

User Views

You can use superfiles to create logical database views which means that you can limit user access
to certain data. For example, you may want users to be able to access certain fields from two files,
but not all the fields from both files. You can create a transaction linking the two files, and remove
the fields you don't want the users to see. By creating a superfile from the transaction and allowing
users to access the superfile but not the original files, you can achieve a degree of data security.

Transaction Templates

You can use superfiles as transaction templates which users can use as a basis for their own
transactions. You can create a transaction in which files are already linked and complicated or
lengthy selection criteria, logical condition processing statements or calculation statements are
already entered, thus saving the user time and trouble.
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Superfiles which a user is authorized to use appear in the File Selection List window marked with
the file access code you defined. Only the superfiles which are applicable to the transaction type
selected are displayed. When a user selects a superfile, it is made available to him for modification
and subsequent execution as follows:

What Users Can Modify in a Superfile
A superfile provides a basis for a transaction, but users can change the following;:

® Sort and control fields
® Display fields

" System functions

" Selection criteria

" SQL

® Logical conditions

B Calculations

Modifications which users make to a superfile are only valid for the user transaction they are made
in.

What Users Cannot Modify in a Superfile

Users cannot modify the fields and the files used in the superfile for their own transaction. Con-
sequently, fields suppressed in a superfile will not be available to the user.

Only the Super Natural administrator can change superfile file specifications.

What are Superfile Profiles?

Superfile profiles consist of file option settings and a list of the users authorized to use the file.

DDIFY Superfile

Options sers

| Note: Superfile options override user options.
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For further information on option hierarchy, see User Profile, Option and Adabas Password
Hierarchies in Technical Information.

Listing Superfiles

~ To obtain a list of existing superfiles
s Issue the SUPERFILE command.
Or:
Select the object Superfile from the Administration Menu.

The Superfile List screen appears:
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Adding Superfiles

~ To add a superfile

1  Add and save the transaction you want to be the basis of your superfile.
2 Invoke the Superfile List screen as described in the previous section.

3  Issuethe ADD SUPERFILE name command.

The name can be a 1-32 character value and does not need to be the same as the transaction
ID.

The Add Superfile window appears:

14:37 A Super Natural s 1999-05-21
SBE - Superfile List - SNMSL
More: -+

Cmd Superfile Name o Add Superfile------------ +
* | ©

!
SPES-UP ! Superfile name ©

|
SUE-SUPER ! SUPER-NEW !
SUP-AAA ! o

!
SUP-CCC ! Copy from program: <

!
__ SUP-HALLO ! ©

|
__ SUP-REP ! Library prefix .. P ©

|
__ SUPER ! Library name .... ©

|
__ SUPER-FILE-DEUF ! ©

|
_ SUPER-FILE-DREI ! Program prefix .. I ©

|
_ SUPER-FILE-EINS ! Program name .... ©

|
__ SUPER-FILE-SQL ! ©

|
SUPER-FILE-UFIL f===c==cc===cc===cssc==scc=cs==sc===c=-= 4

4  Type the prefix of the library in which the transaction is stored in the Library Prefix field.
5  Type the name of the library in which the transaction is stored in the Library Name field.
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6  Type the program prefix of the transaction in the Program Prefix field.
7 Type the ID of the transaction in the Program Name field.
8  Press Enter.

The Modify Superfile >Options screen appears. You can now set options and authorize users
to use the file you have added. For further information, see Modifying Superfiles.

~ To modify a superfile
m  Issue the MODIFY SUPERFILE name command.
The Modify Superfile >Options screen appears:
You can either modify the file options or modity the user list.

For information on navigating between profile setting groups, see Navigating Between Profile
Setting Groups in Introduction.

| Note: Users must restart their Super Natural sessions before your modifications are valid.

Your modifications are valid for all new transactions but not for existing ones.
Options

| Note: Superfile options override user options. For further information on option hierarchy,

see User Profile, Option and Adabas Password Hierarchies in Technical Information.
> To specify Options

1 Choose >0ptions, the Modify Superfile >Options screen appears.
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18:43 s Super Natupal sesssss 1999-05-16
- Modify File BBFILE >Options - SRMFMO

_ DDM Check / Display Options

Database Access

Replace Superfile Specification

>Users

Mark function(s) or select by cursor

Command ===

Enter=PFl===PF2===PF3===PFhl===PF5===PFo===PF7===PF8===PF9===PFLO==PFLL==PFl2===
Help Exit Flip Canc

2 Mark the group(s) of options you want to modify.
3 Press Enter.

4 Overtype the options you want to modify if you are modifying a superfile.
Or:
Type settings if you are adding a superfile and press Enter.
You modifications/entries are saved.

Note: When you add a superfile the file has no option settings and no user list. The individual

file settings which are part of each user profile are valid for users when accessing this su-
perfile if you leave the options settings and/or the user list blank. Otherwise, options set
for a superfile in its superfile profile override options set for a it in a user profile.

You can modify the following options:
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DDM Check / Display Options

Option Description

DDM Checking on Modify Y indicates that each time a Super Natural-transaction is modified, a
check is made to see if the transaction is still consistent with the data
definition module (DDM) for the file or files involved. A warning is
issued when a user modifies a transaction if the DDM has been
changed.
N indicates that no check is to be made. Any changes made to the
DDM since the transaction was created/last modified are ignored.

The default is N.
Prefix for Inverse Field Prefix used for files with both fields in regular and inverse format.
Output See Super Natural in Inverse Mode in the Setting up Super Natural docu-

mentation. The default value is blank.

Display Occurrences (Mul- The default number of occurrences (i.e. values) that are to be displayed
tiple Value Field) for a field defined as a multiple value field. The default setting is 1.

Display Occurrences (Peri- The default number of occurrences that are to be displayed for a field
odic Group) contained within a periodic group. The default setting is 1.

Suppress Numeric Sign  Yindicates that the sign of a numeric field is to be suppressed on the
transaction report.
N indicates that the signs of numeric fields are not to be suppressed.
The default setting is N.

Run Modes Available ONLINE run mode allows users to access the file online.
BATCH run mode allows users to access the file in batch operation.

Database Access

Option Description

Physical Read Allowed Y indicates that a physical read of an entire file is allowed in the case of
a transaction in which the selection criteria specified requires such.
N indicates that a physical read of an entire file is not allowed. The default
setting is Y. This option allows separate settings for online and batch run
mode. This option must be N for DL/I files.

Non-Descriptor Criter- Y indicates that a transaction may use selection criteria that contain non-
ia Allowed descriptors, i.e., fields that have not been defined as key fields.
N indicates that the transaction may only use selection criteria comprised
of key fields. The default setting is Y. This option allows separate settings
for online and batch run mode.

Maximum Number of The maximum number of criteria permitted within a transaction . The
Criteria default setting is 99. This option allows separate settings for online and
batch run mode.
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Option Description
Adabas Sorting Al- Y indicates that the Adabas internal sort feature may be used for a trans-
lowed action that contains sort criteria comprised of one to three key fields.

N indicates that the Adabas internal sort feature may not be used. The
default setting is Y. This option allows separate settings for online and

batch run mode. This option must be N for DL/I files.

Buffer/External Sorting Y indicates that a buffer or external sort feature may be used.
Allowed N indicates that a buffer or external sort feature may not be used. The
default setting is Y. This option allows separate settings for online and

batch run mode.

Adabas Password If an Adabas file that is security protected is to be available to Super
Natural transactions, the password for the file must be provided. See the
Adabas Security documentation for additional information on Adabas se-

curity.

Adabas Cipher Code If an Adabas file that is ciphered is to be available to Super Natural
transactions, the cipher code for the file must be provided. See the Adabas
Security documentation for additional information on Adabas ciphering.

Replace Superfile Specification

You use the Replace Superfile Specification function to update the current superfile if you
have modified the transaction it uses. The Replace Superfile Specification function replaces

the transaction on which the superfile is based with the transaction you specify.

When you choose the Replace Superfile Specification function, the Replace Superfile Specific-

ation window appears:

14:12 s SUpelr Natural e

- Modify File CF-SUPER >0Options -

Superfile
DDM Check / Display Option
Database Access Copy from

Library
Library

Replace Superfile Specific

Program

+ -
|

|

|

|

|

|

|

|

|

|

! Program
|

CF-SUPER

name

program:

prefix ..
name ....

prefix ..
name ....

1995-05-17

SRMFMO

Replace Superfile Specification--+
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~ To replace the superfile transaction specification

1 Inthelibrary Prefixfield, type the prefix of the library which contains the transaction with
which you want to replace the current superfile specification.

2  Inthe Library Name field, type the name of the library which contains the transaction with
which you want to replace the current superfile specification.

3 IntheProgram Prefix field, type the program prefix of the transaction with which you want
to replace the current superfile specification.

4 Inthe Program Name field, type the name of the transaction with which you want to replace
the current superfile specification.

5 Press Enter.

Note: Existing transactions which use the old version of the superfile are not affected by the

Replace Superfile Specification function.
Users

When you choose >Users, the Modify Superfile >Users screen appears as in the following example:

14:39 s Super Natural == 1999-05-21
SBE - Modify File SUPER-FILE-SQL >Users - SRMFMU

Cmd User Access Password

*

__ CF R

_ KE R

Add Add Multiple: _
>0ptions

Cmd(s): Add, Modify, Delete
Select one command from Tist

Command ===
ENtEr=PFl===PF2===PF3===PFl===PF5===PFG===PF/===PF8===PF9===PFLO==PFll==PF12===
Help Exit Flip A Canc

The Modify Superfile >Users screen displays the following information:
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® Users which are authorized to use the superfile you are modifying
® Code for the data access level the user has for each superfile

® Whether the user has an Adabas password for password protected superfiles.

You use the Modify Superfile >Users screen to link users to (authorize them to use) the superfile
you are modifying/adding or to modify or delete existing links.

If you are adding a superfile, the Superfile >Users screen is empty.

Adding / Linking Single Users to a Superfile

~ To add (link) a user to a superfile

1 Issue the ADD USER name command.

The Add/Modify Link to User window appears:

14:39 *xxk%% Super Natural ***x** 1999-05-21
SBE - Modify File SUPER-FILE-SQL >Users - SRMFMU
<«
Cmd User Access Password +--Add/Modify Link to User--+
* 1 ©

!
__ CF R ' User ID ....... KE !
mo KE R ! ©

|
_ I Access ........ R ©

|
— ' <

!
o I Password set .. <

|
_ I Password ...... !
— ! <

!
B +

2 Determine the user's access level to the superfile by typing one of the following codes in the
Access field:

70 Administration



Superfiles

File Access Code |Description

R Read only.

U Update (includes read). The user can update existing records in this file. Not available
under Natural Security.

A Add (includes update). The user can add new records to this file. Not available under
Natural Security.

D Delete (includes add). The user can delete records in this file.

Enter a password in the Password field (optional).

Users who do not have the same password cannot access transactions in public or common
libraries created by this user using this superfile.

For further information on passwords, see User Profile, Option and Adabas Password Hier-
archies in Technical Information.

4  Press Enter.

The user is now authorized to use the superfile at the access level specified.

Adding / Linking Multiple Users to a Superfile

~ To link multiple users to a superfile

1  Mark the Add Multiple field on the Modify Superfile >User screen.

The Add/Link Multiple Users window appears:
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14:39 *xxx% Syper Natural xxx*x* 1999-=05=21
SBE - Modify File SUPER-FILE-SQL >Users - SRMFMU
o
Cmd User Access Password +----Add/Link Multiple Users----+
w3 ! User ID Access Password !
_ CF R ! *x .
|
’ KE R | *kkkkk*k l
_ LA _ !
_ | _ A _ !
_ I AAl _ !
_ I AA2 _ !
_ I AA3 _ !
. I AAd _ !
_ I AAS _ !
_ I AA6 _ !
_ I AAY _ !
Add Add Multiple: c I _ AA8 _ !
I AA9 _ [
>Options ! ©
|
Cmd(s): Add, Modify, Delete +More:  A------o-o-oo--o--o---- +
Mark users for function ADD MULTIPLE ©

2 Mark each user you want to use the superfile.

3 Type in a superfile access code for each user.
For further information on superfile access codes, see Adding / Linking Single Users to a Su-
perfile in Superfiles.

4  Type in a password for each superfile (optional).

5  Press Enter.
The users are now authorized to use the superfile at the access levels specified.
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Modifying Links to Users

You can modify the access code and Adabas password for users already authorized to use the
superfile.

~ To modify a link to a user

1 Issue the MODIFY user command.

The Add/Modify Link to User window appears.
2 Modity the superfile access code (optional).

If the Password Set field is marked, a password is already defined for the superfile. You can
either change or delete the password.

3  Type anew password in the Password field to change the current password (optional).
Or:
Type blanks in the Password field to delete the current password (optional) and press Enter.

The user is now authorized to use the superfile at the access level specified.
Deleting Links to Users

You can delete the link from the superfile to a user, the access code and Adabas password for su-
perfiles the user is already authorized to use.

~ To delete a superfile from the superfile list

1 Issuethe DELETE user-id command.

2 Confirm the deletion in the window which appears.

The user named is no longer authorized to the superfile.

Deleting Superfiles

~ To delete a superfile

1 Issuethe DELETE SUPERFILE superfile-name command.

2 Confirm the deletion in the window which appears.
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This section describes user files and covers the following topics:
This section covers the following topics:

® What are User Files?
= What are User File Profiles?
® Listing User Files

Modifying User Files

Deleting User Files

What are User Files?

User files are created by users and are stored in the personal database. The personal database
consists of one or more physical Adabas files. Each user works on one file which is determined in
his profile.

The user ID of the user who created it is part of each user file name. The user ID is checked each
time a transaction using a user file or with Destination USER FILE is run from a private library to
make sure it is the same as the private library ID.

For further technical information on user files, see Personal Database in Technical Information.

You can use the following commands with the object User File:

ADD |MODIFY |COPY |DELETE |INFO |IMPORT [MULTIMOD
User File X X

What are User File Profiles?

User File profiles consist of file option settings and a list of the users authorized to use the file.

WODIFY Usar File

Options Users
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| Note: User File options override user options.

For further information on option hierarchy, see User Profile, Option and Adabas Password
Hierarchies in Technical Information.

Listing User Files

~ To obtain a list of existing user files
m  Issue the USERFILE command.
Or:
Select the object User File from the Administration Menu.

The User File List screen appears:
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Modifying User Files

~ To modify a user file

m  Issue the MODIFY USERFILE name command.

The Modify User file >Options screen appears. You can either modify the file options or
modify the user list.

For information on navigating between profile setting groups, see >Navigation in Introduction.

| Note: Users must restart their Super Natural sessions before your modifications are

valid. Your modifications are valid for all new transactions but not for existing ones.
Options

User file options override user options.

For further information on option hierarchy, see User Profile, Option and Adabas Password
Hierarchies in Technical Information.

~ To specify the Options

1 Choose >0ptions, the Modify User File >Options screen appears:
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14:44 st Super Natuipgl s 1999-05-21
SBE - Modify File UF-HAH-A23 >Options - SRMFMO

«

Display Options ©

Database Access ©

User File Expiration Date ©

>Users o
Mark function(s) or select by cursor ©
Command === ©

Enter=PFl===PF2===PF3===PFl===PF5===PFE===PF/===PF8===PFY===PFLO=-=PFLLl==PFl12===
Help Exit Flip Canc <

2 Mark the group(s) of options you want to modify.

3  Press Enter.

4 Overtype the options you want to modity if you are modifying a user file.
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Or:

Type settings if you are adding a user file.

5 Press Enter.
You modifications/entries are saved.

When you link a user to a user, file the file has no option settings and no user list. The individual
file settings which are part of each user profile are valid for users when accessing this user file if
you leave the options settings and/or the user list blank. Otherwise, options set for a user file in
its user file profile override options set for it in a user profile.

You can modify the following options:

Display Options
Option Description
Prefix for Inverse Field Output Prefix used for files with both fields in regular and inverse format.

See Super Natural in Inverse Mode in Setting up Super Natural. The
default value is blank.

Display Occurrences (Multiple The default number of occurrences (i.e. values) that are to be dis-
Value Field) played for a field defined as a multiple value field. The default
setting is 1.

Display Occurrences (Periodic The default number of occurrences that are to be displayed for a
Group) field contained within a periodic group. The default setting is 1.

Suppress Numeric Sign Y indicates that the sign of a numeric field is to be suppressed on
the transaction report.
N indicates that the signs of numeric fields are not to be sup-
pressed. The default setting is N.

Run Modes Available ONLINE run mode allows users to access the file online. BATCH
run mode allows users to access the file in batch operation.

Database Access
Option Description

Physical Read Allowed Y indicates that a physical read of an entire file is allowed in the case of
a transaction in which the selection criteria specified requires such.
N indicates that a physical read of an entire file is not allowed. The default
setting is Y. This option allows separate settings for online and batch run
mode. This option must be N for DL/I files.

Non-Descriptor Criter- Y indicates that a transaction may use selection criteria that contain non-
ia Allowed descriptors, i.e., fields that have not been defined as key fields.
N indicates that the transaction may only use selection criteria comprised
of key fields. The default setting is Y. This option allows separate settings
for online and batch run mode.
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Option Description

Maximum Number of The maximum number of criteria permitted within a transaction. The

Criteria default setting is 99. This option allows separate settings for online and
batch run mode.

Adabas Sorting Al- Y indicates that the Adabas internal sort feature may be used for a trans-
lowed action that contains sort criteria comprised of one to three key fields.
N indicates that the Adabas internal sort feature may not be used. The
default setting is Y. This option allows separate settings for online and
batch run mode. This option must be N for DL/I files.

Buffer/External Sorting Y indicates that a buffer or external sort feature may be used.

Allowed N indicates that a buffer or external sort feature may not be used. The
default setting is Y. This option allows separate settings for online and
batch run mode.

Adabas Password If an Adabas file that is security protected is to be available to Super
Natural transactions, the password for the file must be provided. See the
Adabas Security documentation for additional information on Adabas se-
curity.

Adabas Cipher Code If an Adabas file that is ciphered is to be available to Super Natural
transactions, the cipher code for the file must be provided. See the Adabas
Security documentation for additional information on Adabas ciphering.

User File Expiration Date

The User File Expiration Date window contains the following information about the user file:
Information Description

User File Name  The name of the user file as assigned by the user.

User File DBID  Physical ID of the Adabas database used to store the user file (see User File
Adabas Database ID in User profile).

User File Number Number of the Adabas file used to store the user files (see User File Adabas
File Number in User profile).

User ID of the user who created the user file.
Description Three-line description entered by user creating the file.
Created on: Date of creation.

at: Time of creation.

Status Status of the file as follows:
IN USE: Field definitions (and possibly data) exist for this file.
DATA DEL: Field definitions exist. Data has been cleared.
FILE DEL: File has been deleted logically but can still be retrieved.
wxxxxxxt: Deletion currently in process.

Record Count Number of records contained in the file.
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You can set an expiration date for the file.
Option Description

Expiration Date Type the file expiration date in the format YYYY-MM-DD.

Users

When you choose >Users, the Modify User File >Users screen appears as in the following example:

14:44 xxxFE Super Natural **x** 1999-05-21
SBE - Modify File UF-HAH-A23 >Users - SRMFMU
More: -
Cmd User Access Password
*

__ AAl R

__ AA2 D

__ AA3 U

__ AA4 R <

Add Add Multiple: _
>0Options

Cmd(s): Add, Modify, Delete
Link to User modified

Command ===
ENter=PFl===PF2===PF3===PFl===PF5===PF6===PF7===PF8===PFY===PFLO==PFlil==PFl2===
Help Exit Flip 4 Canc

The Modify User File >Users screen displays the following information:

® Users which are authorized to use the user file you are modifying
® Code for the data access level the user has for each

® Whether the user has an Adabas password for password protected user files.

You use the Modify User File >Users screen to link users to (authorize them to use) the user file
you are modifying/adding or to modify or delete existing links.

If you are adding a user file, the User File >Users screen is empty.
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Adding / Linking Single Users to a User File

> To add (link) a user to a user file

1 Issue the ADD USER name command.

The Add/Modify Link to User window appears:

11:35 R SUper Natural === 1999-05-24
- Modify File UF-HAH-A23 >Users - SRMFMU
«
Cmd User Access Password +--Add/Modify Link to User--+
* | <

!
_ AAl R I User ID ....... SBE !
__ AA2 D ! ©

!
_ AA3 U I Access ........ _ <

|
__ AA4 R < ! ©

|
_ I Password set .. ©

|
. I Password ...... !
— ! <

!
_ B +

2 Determine the user's access level to the user file by typing one of the following codes in the
Access field:

File Access Code |Description

R Read only

8) Update (includes read). The user can update existing records in this file. Not available
under Natural Security.

A Add (includes update). The user can add new records to this file. Not available under
Natural Security.

D Delete (includes add). The user can delete records in this file.

F Indicates that the user created the file.

3 Enter a password in the Password field (optional).
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Users who do not have the same password cannot access transactions in public or common
libraries created by this user using this user file.

For further information on passwords, see User Profile, Option and Adabas Password Hier-
archies in Technical Information.

4  Press Enter.

The user is now authorized to use the user file at the access level specified.

Adding / Linking Multiple Users to a User File

~ To link multiple users to a user file

1 Mark the Add Multiple field on the Modify User File >User screen.

The Add/Link Multiple Users window appears:

14:46 FAASkk Super Natural *xxxx 1999-05-21
SBE - Modify File UF-HAH-A23 >Users - SRMFMU
.
Cmd User Access Password +----Add/Link Multiple Users----+
w5 ! User ID Access Password !
___ AAl R ! * »
|
; AA2 D I *khkkkkkk l
__ AA3 U A _ !
__ AA4 R < I AA _ !
_ I AAS _ !
_ I AA6 _ !
_ I AAY _ !
_ I _  AA8 _ !
_ I AA9 _ !
_ I _  AA91 _ !
_ I AA92 _ !
Add Add Multiple: _ I _  AA93 _ !
I AA94 _ !
>Options ! ©
|
Cmd(s): Add, Modify, Delete tMore: Ao +

2 Mark each user you want to use the user file.

3  Type in a user file access code for each user.
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For further information on user file access codes, see Adding / Linking Single Users to a User
File in User Files.

4  Type in a password for each user file (optional).
5  Press Enter.

The users are now authorized to use the user file at the access levels specified.
Modifying Links to Users

You can modify the access code and Adabas password for users already authorized to use the
user file.

~ To modify a link to a user

1

Issue the MODIFY user command.

The Add/Modify Link to User window appears.
Modify the user file access code (optional).

If the Password Set field is marked, a password is already defined for the user file. You can
either change or delete the password.

Type a new password in the Password field to change the current password (optional).
Or:
Type blanks in the Password field to delete the current password (optional) and press Enter.

The user is now authorized to use the user file at the access level specified.

Deleting Links to Users

You can delete the link from the user file to a user, the access code and Adabas password for user
files the user is already authorized to use.

> To delete a user file from the user file list

1

2

Issue the DELETE user-id command.

Confirm the deletion in the window which appears.

The user named is no longer authorized to the user file.
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Deleting User Files

User files can be deleted online and in batch.

> To delete a user file online

1
2

Issue the DELETE USERFILE wuserfile-name command.

Confirm the deletion in the window which appears.

> To delete a user file in batch

Use the program SNDELUEF in library SYSSN as described in the section Batch Utilities.
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This section covers the following topics:

® What are Libraries?

® Creating Libraries

® Listing Libraries

® Copying Libraries

® Deleting Libraries

® Listing Library Members

® Copying Library Members

® Deleting Library Members

® The Information (Info) Function

What are Libraries?

For a definition of private, public and common libraries, see Libraries in Using Super Natural in the

User’s Guide.

You can perform the following commands on libraries:

ADD |MODIFY |COPY |DELETE |INFO [MEMBER
Private Library X X X
Public Library X X X
Common Library X X X

Super Natural libraries can contain the following types of members:

® Transaction programs

" Prototype programs

® Application programs

Data models

® Layout member

® Work-in-progress layout member

You can perform the following commands on members:
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ADD |MODIFY |COPY |DELETE |INFO MEMBER

Member X X X

Creating Libraries

There is no Add Library function.

~ To create a library
Copy an existing library specifying the required library prefix for the target library.

Common libraries are not created until they are defined in the Common Library Definition List
(although they may appear in the Library List).

| Note: Libraries are not created until members are copied to them.

Listing Libraries

~ To list libraries with a certain prefix and member prefix

1 Issue the LIBRARY command.

Or:

Select the object Library from the AdministrationMenu.

The Library List screen appears as in the following example:
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14:49 **%%% Super Natural *****
- Library List -

SBE

Library prefix: Y

Cmd Library Programs

*

DD
DEMO
ESC
EZA
FHA
FSO
HAA
HAH
HAHL
HAHZ
HAH3

HSE

Cmd(s): Copy, Delete, Member
Select one command from 1ist

Command ===

58

48

55

15

13

13

Program prefix:

1999-05-21
SNMLL

More: = aF

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---

Help Exit

The Library List screen shows the following:

® Library prefix
® Member prefix

Canc <«

® The libraries defined to Super Natural with the library prefix and member prefix shown
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® The number of programs with the prefix shown contained in each library shown

2 Enter the prefix for the type of library you want to see in the Library Prefix field.
3 Enter the prefix for the type of program you want to see in the Member prefix field.

The libraries with the prefix specified are listed and the number of programs with the prefix
specified contained in each library is shown.

Copying Libraries

You use the Copy Library function to copy members of a certain type either to an existing or to
anew library. You cannot copy all the members of a library at once. You must copy each member
type separately.

] Notes:

1. When you copy a transaction, its layout member is also copied.

2. If you copy transactions created with Super Natural Version 2.4.2 or below, a dummy layout
member is created for each one.

3. You cannot copy transactions with transaction mode for reporting Destination USER FILE
between libraries.

~ To copy a library

= Issuethe COPY LIBRARY command specifying source and target library prefix and name as in
the following example:

COPY LIBRARY YTEST I ZPUBLIC I

If you enter CO in the command column of the Library List screen next to the library you want
to copy, a window appears which prompts you for prefix and name information.

A window appears showing which members are currently being copied. If there is already a
member with the same prefix and name in the target library, you are asked if you want to
replace (overwrite) the member in the target library.
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Deleting Libraries

You use the Delete Library function to delete members with a certain prefix from libraries. You
cannot delete all the members of a library at once. You must delete each member type separately.

If you delete all transactions, the layout members which belong to them are also deleted. However,
the work-in-progress layout members are not deleted. Work-in-progress layout members (prefix!)
can only be deleted from the Member List screen.

| Note: A library itself is not deleted until all its members are deleted.

> To delete a library

1 Issuethe DELETE LIBRARY command specifying library prefix, library name and program
prefix as in the following example:

DELETE LIBRARY YTEST I

2 Confirm the deletion in the window which appears.
All the programs with the prefix specified are deleted from the library.
Or:

Enter DE in the command column of the Library List screen next to the library you want to delete.

3  Confirm the deletion in the window which appears.

All the programs with the prefix specified in the Member prefix field of the Library List screen
are deleted from the library.

| Note: You must delete common libraries and their definitions separately.

Listing Library Members

~ To list the members contained in a library

m  Issue the MEMBER command specifying library-prefix, library-name and program-prefix.

The Member List screen appears:
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14:50 **Fk%% Syuper Natural **xx* 1999-05-21

SBE - Member List - SNMML
More: +

Library prefix: Y Member prefix: I ©

Cmd Library Member ©

SBE % o

_ AUTO o

_ CONNECT o

_ CONTROL ©

_ CONT2 ©

_ DATACH .

_ DATACHZ »

_ DATACH3 o

_ DATA2 o

_ DATA3 -

_ DATA4 o

_ DATAS o

_ DATAG6 -

o

Cmd(s): Copy, Delete, Info o

Select one command from list ©

Command === ©

Enter=PFl===PF2===PF3===PFi===PF5===PFe===PF7 == =PFE===PF9===PF10=-=PFLl==PFl2==-
Help Exit Flip + Canc «

The Member List screen contains the following information:

® Library prefix
® Member prefix
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® The name of the library whose members are listed - you can overtype this with another
library ID

® The members with the prefix specified contained in the library specified

Copying Library Members

~ To copy a library member

= Issue the COPY MEMBER command specifying library prefix, library name, member prefix and
member name for both source and target member as in the following example:
COPY MEMBER YSBE ISAMPLE3 CTUTOR ISAMPLES3

If you enter CO in the command column of the Member list screen next to the member you
want to copy, the Copy Member window appears which prompts you for name and prefix
information for the target library and target prefix.

In some cases, you cannot copy a transaction to another library because of layout conflicts.

Note: You cannot copy transactions with transaction mode for reporting Destination USER
FILE between libraries.

Deleting Library Members

> To delete a library member

= Issuethe DELETE MEMBER command specifying library prefix, library name, member prefix
and member name as in the following example:

DELETE MEMBER YSBE ISAMPLE3

Note: If you enter CO in the command column of the Member list screen next to the

member you want to copy, the copy member window appears which prompts you for
name and prefix information for the target library and target prefix.
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The Information / Info Function

> To obtain information about a member

s Enter the command abbreviation IN in the command column of the Member List screen next
to the member name.

Or:

Issue the INFO MEMBER command specifying library prefix, library name, member prefix and
member name as in the following example:

INFO MEMBER YSBE IDATA3

The Transaction Information window appears:
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11:47 *FxAF* Syuper Natural ***x** 1999-05-24
- Member List - SNMML
More *

R Transaction Information---------------------- +
I Transaction .......... DATA3 Version .... 3.1.0 ©

|
! Created/modified by .. SBE Date/Time .. 1993/01/12 12:03:00 !
! Description .......... data maintenance transaction t ©

!
! ype UPDATE MULTIPLE ©

|
D Type oo Update single ©

|
I Selection ............ Full-screen ©

|
! Data change .......... None ©

|
! Report type .......... ©

|
I Report Tevel ......... Detailed ©

|
I Destination .......... Screen ©

!
I Run mode ............. Online ©

!
' Primary file ......... PERSONNEL ©

!
I Sec. file ............ <

!
I User file ............ <

!
! o

!
Cmd(s): Co #More: 4---------------omooo oo oo oo oo +
<«
Command === ©

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---

Help Exit Flip +

The Transaction Information window supplies the following information:

®" Transaction name

® Super Natural version with which the transaction was created

Who created/last modified the transaction

When the transaction was created/last modified

Canc <«
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= User-entered transaction description

Information about the transaction modes (Report Type, Data Selection etc.)

Primary file
® Secondary file (if defined)
® Name of user file (for Destination USER FILE)

You can page forward to obtain information on the following if relevant to the transaction:

® Link and lookup fields used.

Selection criteria

Calculation
* Logical conditions

Fields used

When you print the information, you are also provided with information on the entries made
in the Worksheet.
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Common Library Definitions

This section covers the following topics:

® What are Common Library Definitions?

® Listing Common Library Definitions

Adding Common Library Definitions

Deleting Common Library Definitions

What are Common Library Definitions?

A common library definition is a name reserved for a common library which may or may not exist
physically.

You can perform the following commands on common library definitions:

ADD MODIFY |COPY |DELETE [INFO [MEMBER

Common Library Definition | X X

Listing Common Library Definitions

~ To list common library definitions
m  Issue the COMMON command.
Or:
Select the menu item Common Library Definition from the Administration Menu.

The Common Library Definition List screen appears as in the following example:
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14:51 **Fk%% Syuper Natural **xx* 1999-05-21
SBE - Common Library Definition List - SNMEL
More: +

Library prefix: C <

Cmd Library ©

x o

__ AAA o

_ AKE ©

__ BRIGGS ©

__ DEMO ©

__ ERROR -

__ EZA -

__  HWA ©

__ KE -

__ KE24 -

__ LCCOMM2 -

__ NKA =

__ NSNCAQ o

Add o

Cmd(s): Add, Delete ©
Select one command from list ©
Command === ©

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc <
The Library List screen shows the following:

® Common library prefix

® Common libraries which are either in use or for which a name has been reserved.
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Adding Common Library Definitions

When you add a common library definition, you do not create a common library directly, but reserve
aname for one. A common library does not exist physically until you copy members into it.

~ To add a common library definition

n Issue the ADD COMMON common-1library-definition-name command.

A name is reserved for the a common library.

Deleting Common Library Definitions

When you delete a common library definition, the library becomes unavailable for your users but
still exists physically and is listed in the Libraries List screen.

~ To delete a common library definition

1 Issuethe DELETE COMMON common 1ibrary definition-name command from the Common
Library Definition List.

2 Confirm the deletion in the window which appears.

The library is unavailable to users but still exists physically.
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This section covers the following topics:

® Invoking the Special Services Menu
® Importing Users

® Importing Files

Modifying Multiple Users

Layout Standard Title
JCL Members

Invoking the Special Services Menu

~ To invoke the Special Services menu
= Issue the SPECIAL command from the Object List screens.
Or:
Choose the object Special Services on the Administration Menu.

The Special Services Menu appears:
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Importing Users

When Super Natural is operating under the Natural Security system, you can use the Import User
function instead of the Add User function to define users.

| Note: The Import function is only useful for users of Natural Security.

In order to import file profiles, the application SYSSN must be people-protected under Natural
Security.

To import users with private files, the private files must be linked to the application SYSSN.

~ To import users

1  Issue the IMPORT USER name command.
Or:
Issue the IMPORT USER command.

The Import User screen appears as in the following example:
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14:53 **Fk%% Syuper Natural **xx* 1999-05-21

DBA - Import User - SNMUT
More: +

User ID Private Files <

* o

_ ANS o

_ APAXF o

_ AZE ©

_ AZEl ©

_ AZES ©

_  BBU ©

_ BBUBAT -

_ BBUUSERI1 ©

_ BGW <

_  BKA o

_ BSE o

_ BTO -

_ BVUS o

_ CF o

o

Mark users to be imported into SYSSN ©

Command === ©

Ent@r=PFl===PF2===PF3===PFl===PF5===PFG===P[F7 ===PFE===PFY===PFLlO==PFL1l==PF12===
Help Exit Flip + Canc <

The screen lists the users defined under Natural Security and displays the number of private
files for each user.
If you specified a user name, the list starts from that name.

Natural Security users of the types Terminal and Group are not listed.
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2 Mark the users to be imported.

3 Press Enter.

The users' private files are added/linked automatically, if they are not yet defined to Super
Natural.

Users already defined to Super Natural are shown on the list, but cannot be marked.

Importing Files

When Super Natural is operating under the Natural Security system, you can use the Import
File function instead of the Add File function to define users. You can import both private and
public files.

] Notes:

1. The Import function is only available for users of Natural Security.

2. In order to import file profiles, the application SYSSN must be people-protected under Natural
Security. Private files must be linked to the application SYSSN.

~ To import a file

1  Issue the IMPORT FILE name command.
Or:
Issue the IMPORT FILE command.

The Import File > Private screen appears as in the following example:
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14:54 **Fk%% Syuper Natural **xx* 1999-05-21
DBA - Import File >Private - SNMFI

«

File Name Type ©

* ©

CO-AGREEMENT Priv ©
COMMAND-SSZ Priv ©
UF-SEK-BSP51 Priv ©

UF-SEK-BSP6 Priv ©

>Public <
Mark files to be imported to SYSSN @
Command === <
Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11l--PF12---

Help Exit Flip s Canc <
The screen lists the private files that are already linked to the application SYSSN.

Files already defined to Super Natural are shown on the list, but cannot be marked.

2 If you want to import a public file, issue the >PUBLIC command.
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The Import File >Public screen appears. The screen lists the public files that are already linked
to the application SYSSN. Files already defined to Super Natural are shown on the list, but
cannot be marked.

3 Select the file(s) to be imported.

4  Press Enter.

The file(s) have been imported to SYSSN.
5  Press Exit to enter the File List and select the desired File.
6  Press Enter.

7 Modify the file options as described in the section Files earlier in this documentation if required.

Modifying Multiple Users

You use the Modify Multiple Users function (called Mass Change in previous versions of Super
Natural ) to unify the options of multiple (or all) users.

~ To modify multiple users

1 Issue the MULTIMOD command.

The Modify Multiple Users window appears:
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11:08 *xxx% Syper Natural xx**x* 1999=05=24
- Special Services Menu - SNM14
<«
R Modify Multiple Users--------- +
! ©

!
IM USER Import Users I Enter a user ID to get the options of !
IM FILE Import Files ! this user as default options. ©

|
I If using '*******' you will get the <«

!
MULT Modify Multiple | global options as default. ©

!
| ©

!
TITL Layout Standard ! User ID: ©

!
! ©

!
JCL JCL Members Sl +

Enter the user ID whose options you want all or multiple users to get.

The Multiple Modify Multiple Users >Options screen appears:
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11:11 *FxAx% Super Natural ***** 1999-05-24
- Modify Multiple Users >0ptions - SRMUQO

-

-

_ Maintenance Authorization / Language / Prefixes ©

-

_ Sizes / Numbers / User Files ©

o

_ Database Access <

-

_ Database Access and JCL ©

w

_ Data Maintenance Transaction Type / Data Selection ©

_  Report Type / Report Level ©

_  Report Destination / Run Mode / Batch Job Entry ©

-

_ Display Options ©

-

.

>Users o
-

Command === <

Enter=PFl===PF2===PF3===PFl===PF5===PFE===PF/===PF8===PFY===PFLO=-=PFLLl==PFl12===
Help Exit Flip Canc <

3  Modify the user options as described in the section Modifying Single Users earlier in this section
if required.

4  Select >Users.
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The Modify Multiple Users >Users screen appears as in the following example:

11:12 RS Super Natuiral == 1999-05-24
- Modify Multiple Users >Users - SNMUQL
More: +
User ID <
*— <
e _ AA92 _  CALL 'C _ DP ©
_ A _  AA93 _ CCA _ DS ©
_ AA _  AA94 _CCH _ DW o
_ AAl _ AKR _ CF _ ESC e
_ AA2 _ ALO _ CHEF _ EZA o
_ AA3 _ AS _ CMR _ FHA ©
_ AA4 _ AZ _ CR _ FK ©
_  AAS _ Al _ DA _ FS ©
_  AAG _  BF _ DBA _  FSO ©
_ AA7 _  BFA _ DEMO _ FT ©
_ AA8 _ BFB _ DEMO1 _  GAS ©
_ AA9 _  BFC _ DEMO2 _  GBAH o
_  AA91 _ BS _ DOG _  GBBW e
-
-
Mark users for function Modify Multiple ©
Command === ©

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Help Exit Flip + Canc «

5 Mark the users you want to give the new user options.

Marked users are modified when you do one of the following:
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* Issue a paging command.
" Press Enter.

® Press PF3.

Layout Standard Title

You use the Layout Standard Title function to edit the standard Title element which is generated
for all reports at your site. For example, you may want the name of the company to appear at the
top of all reports. Users can edit the Title element in each report.

Editing the Layout Standard Title Element

~ To edit the standard Title layout element

1 Issuethe TITLE command.

The Layout Editor appears with the Standard Title element currently defined at your site in
the editor area.

2 Edit the Standard Title as described in the section Natural Report Manager in the User’s Guide.

Super Natural provides the following default Standard Title element:

— *0OTX With VY¥Y—M DD *P1GE -NUME ER —
5 Lines —
/14:5 £2% NATURAL REPORT MBMAGER *+# 1993 5-23
Layolt STOTITLE - Lagout Edikor - WRpEDTIT
tore: =
Trqnsaction Fislds DElifdter Class  Attrik. Colo
1 *D4TD a8 Blank Text Defanlt
2 *DATE a8 2 Text Intens.
3 ADATE 115 i output  Defanlt
4 *DATI as 1 output  Intens.
5 #DATT a5
& *DATN Hg.0 Efcape Char. = .  Header Char.
B1l | —==010-mmdmmmmdmmmmdmmm030-= [ Titlé | A== 050 mdmmmm g e bem =070
i B
[
[

&
Ty
(2991
TE1
TE1

Tou|are pn the £irst page.
confand F==>
Entgr—FFH-——FF2==—FF3==—FFd == —FF 5= G == —FF == —FF§-=—FF9--—FF10-—FF11--FF12-—-

l\ Heflp Set  Exdt Fdield Bdit Flip - + Tech < = Canc /

— *PREOGF AW
(TS ACLON NAknE Al prefiy)

s —
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System Variables

The Natural system variables available in Super Natural are listed in the Transaction Fields
section of the split-screen Layout Editor. For further information on system variables, see System
Variables in the User’s Guide.

S Lines

The S lines are a placeholder for up to 5 lines of selection criteria. Each S line contains 60 Ss. If you
either add or erase Ss from the S lines, the Ss are interpreted as text. You can edit the S lines if you
wish, for example, you can move them two lines down and enter text above them.

Deleting the Standard Title

You can delete the contents of the Standard Title member in the Super Natural Administration
application. The next time you choose Layout Standard Title from the Special Services menu,
the Layout Standard Title window appears where you can choose between editing the empty
Standard Title and regenerating the Super Natural default Standard Title.

You can delete the Standard Title member in SYSSN, however it is regenerated the next time a
layout is generated for a transaction.

JCL Members

You use the JCL Members function to maintain JCL members using the Natural LIST command.
By default, each JCL member is stored in library Z]JCL. Choosing JCL Members from the Special
Services menu is the same as issuing the following Natural commands:

LOGON LIBRARY ZJCL
LIST *

A user can only have access to one JCL at a time. However, you may create several JCLs in the
library ZJCL. You can change user access to JCLs as necessary using user options.

You can perform the following commands on JCL members:

DELETE |EDIT |LIST |PRINT |RENAME
JCL Member |X X X X X

Although other commands are available using the Natural LIST command, these are the only
commands necessary for JCL member administration.

For further information on using Super Natural in Batch Mode, see Batch Processing.
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The library ZJCL should only be used for storing JCL members.

Invoking the JCL Members Function

> To invoke the JCL Members function

m  Issue the JCL command.

You have now accessed the Natural LIST command. The Natural LIST COMMAND LIST P
* screen appears as in the following example:
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Deleting JCL Members

> To delete a JCL member

1  Enter DE in the command column next to the JCL member you want to delete.

2 Confirm the deletion in the window which appears.

The JCL member is deleted.

Editing JCL Members

> To edit a JCL member

= Enter ED in the command column next to the JCL member you want to edit.

The Natural Program Editor appears where you can edit the JCL member. For information
on editor handling, see the Natural Reference documentation.

Listing JCL Members

> To list a JCL member

= Enter LI in the command column next to the JCL member you want to list.

The JCL member is displayed in the Natural Program Editor. For further information on the
Natural Program Editor, see the Natural Reference documentation.

Printing JCL Members

~ To print a JCL member

= Enter PR in the command column next to the JCL member you want to print.

The JCL member is printed.
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Renaming JCL Members

> To rename a JCL member

1  Enter RE in the command column next to the JCL member you want to rename.

2 Type anew name in the window which appears.

JCL member names can have 1 to 8 characters.

3  Press Enter.
The JCL member is renamed.

For further information on the Natural LIST command, see the Natural Reference documentation.
Writing JCL Members

For information on creating JCL members, see Writing JCL Procedures in Batch Processing.
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This section describes set-up for batch transactions, RJE, JCL and the Super Natural batch utilities.
This section covers the following topics:

® What is Batch Processing?

Setting Up Batch Processing

Setting Up Batch Processing for Remote Job Entry (RJE)
Writing JCL Members

Maintaining JCL Members

Notes for Natural Security Users

Job Submission

What is Batch Processing?

You use batch processing to manage resources efficiently by processing large numbers of records
and printing long reports at off-peak times.

In order to run transactions in Batch mode, you must have either Natural PROCESS or NATRJE
for your environment. You maintain the control procedures for your system environment in the
Super Natural Administration application using the JCL Members function which in turn accesses
the Natural LIST command.

The Super Natural administrator must organize the following:

" Setting Super Natural user options

® Deciding which users should be able to create and run batch transactions

Writing JCL procedures

Maintaining JCL members

Deciding how batch jobs should be submitted

Security and other issues.
By default, each JCL is stored in library ZJCL.
JCL member names should have 1 to 8 characters.

A user can only have access to one JCL at a time. However, you may create several JCL members
in the library ZJCL. You can change user access to JCL members as necessary in their user options.

Variable parameters which must be changed by the user before execution of the batch job can be
defined using text strings as long as they do not coincide with the job control language. You can
modify the system exit SPRJEU so that it can provide the control procedure with user variables.
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Once a job has been submitted to run a Super Natural batch transaction, do not modify the trans-
action until after the job has been run. Modifying the transaction can either cause an error or incor-
rect resulting data. For example, if a user changes the transaction defaults to Run Mode: ONLINE
between batch job submission and execution, the batch job will terminate with an error.

] Notes:

1. Super Natural batch transactions terminate the batch Natural session.

2. Note for BS2000/OSD users:
If you want to run a batch transaction online, do not generate ETID parameters. For further in-
formation on ETID parameters, see your Natural Security documentation.

3. Itis not possible to run transactions which use dynamic input fields in Batch mode.

Setting Up Batch Processing

> To enable a user to run transactions in Batch mode

1 Assign the desired logical printer number for transactions in Batch mode.
2 Set the option JCL ID to determine which JCL member the user will use (default JCL01).
3  Set the appropriate user options for Report/Logging DestinationtoY.

The following Report/Logging Destinations are available for transactions in Batch mode:

PRINTER
WORK FILE
CON-NECT
USER FILE

4  Set the user option Run Mode: BatchtoY.

5  Set the Natural PRINTER parameter high enough for the code generated by Super Natural to
pass the syntax checker in the online Natural session in which Super Natural is running.

For example, if the report destination is logical printer number 8, PRINTER=8 (or higher)
must be used. You can check the printer, work file and PC file numbers allocated using the
Natural utility SYSDBA.

You can set the PRINTER parameter in the Natural parameter module or dynamically.

The user can now save and run batch transactions.
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You can also authorize users to use certain user options (for example, non-descriptor criteria)
only in Batch mode.

Setting Up Batch Processing for Remote Job Entry - RJE

The RJE facility allows users to submit batch transactions from within Super Natural without
having to write the JCL themselves.

~ To enable a user to submit batch jobs by RJE

1  Set the user's options as described in the section Setting Up Batch Processing earlier in this
section.

2 Set the user option Batch Job Entry: RJE Availableto.

3 Code the JCL for the Natural batch job.
You can specify unique JCL members for each user, or more than one user for the same JCL.
For further information, see JCL Members in Special Services for Batch Transactions.

4  Store JCL members as source members in the Natural library ZJCL.

To activate batch RJE, the user must set the transaction mode Run Mode to B using the MODES
command from within the transaction he wants to submit.

Now the user can run transactions in Batch mode and the batch jobs will be automatically
submitted.

Writing JCL Members

JCL members for use with Super Natural RJE are written the same way as any Natural batch job
for your site, except for the Super Natural special characters described below.

Special Characters

The following special characters are available when creating or modifying JCL members for the
submission of batch transactions:
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Insert Character > (Mandatory)

Code the insert character ">" in column two on a line by itself.

Super Natural inserts the correct LOGON and EX commands when the transaction is submitted to
RJE.

The insert character ">" allows a JCL member to be used repeatedly by the same and multiple
users without modification.

Example:
The following example shows how the insert character ">" works. The insert character is used in
the JCL for a transaction named REPORT1 for the user USERID as follows:

>
FIN

When the job is submitted, Super Natural inserts commands to change the instream data to the

following:

LOGON SYSSN

EX IREPORT1 YUSERID

FIN

where I is the program prefix for transactions, and Y is the private library prefix.

User ID Generation (Recommended)

The characters "******" are replaced by the User ID at the time the transaction is submitted for
execution. You can use this character string in the job card.

Transaction Name Generation (Optional)

The characters "#######" are replaced by the transaction name when the transaction is submitted
for execution as in the following example:

Example:

[ [x¥wxxxx JOB JHHHHHHE, MSGCLASS=X, CLASS=G
//NATBAT EXEC

Active PSB Name Generation (Optional)

The characters "pppppppp" are replaced by the active PSB name (DL/I files) at the time the trans-
action is submitted for execution (only for DL/I files).
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Maintaining JCL Members

For information on maintaining JCL members, see JCL Members in Special Services.

Notes for Natural Security Users

The Natural Security environment must be set up so that the startup program MENU is active
when batch processing is invoked. MENU reads the Natural commands which follow as input
data, and controls the execution of the transaction.

If there is not a control record for the transaction, batch processing is not started.

The control record is created from the online environment before batch processing is started. Batch
transactions are registered with Super Natural.

Transactions which are not registered with Super Natural can only be run if they are in the private
library of the user, in a public library the user can access or if the relevant library is defined under
Natural Security and the transaction processing is started from that library.

Set-Up

Super Natural must be set up according to the instructions in the Setting up Super Natural docu-
mentation.

AUTO=0ON
User Type Person or Administrator.

If the user submitting the batch job is defined to Natural Security as a user of the type Person or
Administrator and AUTO=0N is specified, the job name itself is used to perform the logon and the
Natural Security logon need not be coded in your JCL. For further information, see Generating
User ID’s in Dynamic Features.

User Type Member

If the user is defined as a user of the type Member, AUTO=0N can still be used if the default application
for that user ID is SYSSN.

If the member's default application is not SYSSN, the Natural Security logon commands must be
coded in the JCL as in the following example:

SYSSN, USERID
%*

PASSWORD
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RESTART=N (Natural Security Version 2)

In Natural Security Version 2, define the application SYSSN with RESTART=N on the application
profile. Restart data is not used in Super Natural, and turning RESTART off will prevent a duplicate
user ID from occurring.

n_n

Insert Character ">

If Natural Security is installed, use the insert character ">"as the Super Natural MENU program
expects the execute card in a specific format. For further information on the insert character">",
see Special Characters in Writing JCL Members.

If the RJE facility is being used to submit batch jobs from Super Natural, use the insert character">"
which allows Super Natural to insert the LOGON SYSSN and EX IPGMNAME YLIBRARY commands.
For further information on the insert character ">", see Special Characters in Writing JCL Members.

If you do not use the RJE facility (i.e., the JCL is to be submitted outside of Super Natural), you
can code the Natural control statements in two ways.

If private libraries are not defined to Natural Security code the Natural control statements as follows:

LOGON SYSSN
EX IPGMNAME YLIBRARY

If private libraries are defined to Natural Security code the Natural control statements as follows:

LOGON YLIBRARY
EX IPGMNAME

Naming Conventions:

If you do not use the insert character ">", and hard-code the control statements, the transaction
name must consist of eight positions. If the name has less than eight characters, it must be padded
to eight positions with trailing blanks. For example, if you want to run the transaction ITEST in
library YSALZC, the following will result in an error under Natural Security:

LOGON SYSSN
EX ITEST YSALZC

The correct version is as follows:

LOGON SYSSN
EX ITESThlanks YSALZC

where bTanks are three trailing blanks you must enter for the five-character ITEST transaction.
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Super Natural generates the commands correctly when the insert character ">" is used. For further
information on the insert character ">", see Special Characters in Writing JCL Members.

Job Submission

JCL members for external submission are coded the same way as any Natural batch jobs for your
site.

To log on to SYSSN and execute the transaction from the user's private library, code the Natural
control statements as follows:

LOGON SYSSN
EX IPGMNAME YLIBRARY

To log on directly to the private library and execute the transaction, write the Natural control
statements as follows:

LOGON YLIBRARY
EX IPGMNAME

| Note: Users of Natural Security should see Notes for Natural Security Users in Batch Pro-
cessing.

Submitting Batch Jobs Using Natural PROCESS

To submit batch jobs using Natural PROCESS

1  Change the submission indicator in the Natural subprogram SPPARM from RJE to NPR.
2 Specify a process node ID.

For further information, see the SPPARM source.
Modifying Submitted Batch Jobs - SPRJEU

The Natural subprogram SPRJEU is delivered in source form.

When Super Natural transactions are run in Batch mode, the subprogram SPRJEU is executed
once for every job card prior to the submission of the job by NATRJE.

You can use NATRJE to add, modify and delete job cards. For further information, see the SPRJEU
source.
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This section describes the batch utilities provided with Super Natural.
This section covers the following topics:

® What are Batch Utilities?

® Unloading and Loading Super Natural Data

= SNULD

SNLOAD

SNDELUEF?2 - Deleting User Files in Batch
SNSORTFI - Sorting File Links in User Profiles

What are Batch Utilities?

Super Natural provides the following batch utilities:

Batch Utility | Description

SNULD  |Unloads profile data and transaction specifications

SNLOAD |Loads profile data and transaction specifications
SNDELUF |Deletes user files
SNSORTFI |Sorts file links in user profiles

Unloading and Loading Super Natural Data

You use the utilities SNULD and SNLOAD to copy Super Natural user profile data, file profile
data, help texts, and transaction specifications between different Natural user system files (FUSER).
You can also use SNULD to delete profile data and help texts.

] Notes:

1. You cannot load help texts from Super Natural 2.3 to a Super Natural 3.1 environment.

2. Do not use the Natural utilities SYSMAIN or SYSMAIN2 to copy or move Super Natural
transactions between system files. These utilities only copy up to 80 characters per source line
and Super Natural specifications contain up to 250 characters per line.

3. The FDIC file in the target environment must be the same as that in the original environment

if you want to use existing transactions.

Use the Natural Object Handler to copy or move JCL members, prototype programs and objects
between system files.
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For further information on SNULD and SNLOAD, see the following sections.

SNULD

The program SNULD in library SYSSN unloads Super Natural user profile data, file profile data,
help texts and transaction specifications from the current Natural user system file (FUSER) to se-
quential work file 4 in a form suitable to be reloaded using the program SNLOAD.

The following table shows which functions are available for batch jobs using SNULD and which
parameters are required:

Function Code |Object Name |Language Code |Library

%

D Required

F Optional

H Optional  |Optional

S Required Required
U Optional

Functions

* Function

The * function unloads all user and file profiles and help texts. It does not unload transactions.
D Function

The D function deletes objects according to the object name parameter specified. You can use the
following object name parameters with the D function:

X

File profile data, user profile data and help texts

File profile data

Help texts (language specific)

c|T|™

User profile data

All objects of the type specified are deleted.
F Function

The F function unloads either all file profiles (including user file and superfile profiles) or named
file profiles. It does not unload the sources (transaction specifications) of superfiles.
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H Function

The H function unloads either all or named help texts either in all languages or in a specified lan-
guage.

Note: You cannot load help texts from Super Natural 2.3 to a Super Natural 3.1 environment.

S Function

The S function unloads transaction specifications. It does not unload the generated source code
and the Natural object code. To regenerate the Natural source and object code, you must modify
and save every transaction.

You can also use SYSMAIN to copy the transaction objects, so the transactions can be run immedi-
ately in the new environment.

If you do not specify a transaction name and library name containing the appropriate prefix, all
transaction specifications and layouts from all libraries are unloaded.

If you use the asterisk notation (*) following the prefix, all transaction specifications and layouts
or libraries with that prefix are unloaded.

U Function

The U function unloads either all or named user profiles.
Parameters

Parameters must be entered after the function code in the following order:

function-code,object-name,language-code,library

The parameters must be separated from the code and from one another by the Natural delimiter
character. If one of the parameters is not specified, or not applicable, the character preceding it is
still required. For example, if you want to unload all English help texts, the parameters must be
specified as: H, ,1

You can use the asterisk notation with the parameters to further limit the object name and library
of the items to be unloaded. For example the notation S, TR*, , Y* would unload all transactions
whose name begins with TR in the library with prefix Y.

Each function must be written on a separate line (along with its parameters).
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Examples of Recommended Syntax

Example 1

LOGON SYSSN

SNULD

H,.,1

S,TR*, ,Y*

FIN

1: Unloads all English help texts.

2: Unloads all transactions whose names start with TR in libraries with the prefix Y.

Example 2

LOGON SYSSN

SNULD

SRR b

FIN

Unloads all transactions in all private libraries with the prefix Y.

Example 3

LOGON SYSSN

SNULD

S, IPGMNAME, , YUSERID

FIN

Unloads the specified transaction in the library given.

Example 4

LOGON SYSSN
SNULD
S,I*,,YUSERID
FIN

Unloads all transactions in the specified library whose name start with I.
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Example 5

LOGON SYSSN

SNULD

S,*,.YUSERID

FIN

Unloads all transactions in the specified library.

Example 6

LOGON SYSSN

SNULD

F’*
S,*,,public-Tibrary-prefixSUPFILE

FIN

1: Unloads all file profiles including user file and superfile profiles.

2: Unloads the sources (transaction specifications) of the superfiles.

SNLOAD

The program SNLOAD in library SYSSN loads Super Natural user and file profile data, help texts
and transaction specifications from sequential work file 4 to a user system file (FUSER). The data
must be in the same format as achieved by unloading Super Natural data using the program

SNULD.

~ To load Super Natural data

»  Specify the following in a batch Naturalsession:

LOGON SYSSN
SNLOAD

FIN

136

Administration



Batch Utilities

SNDELUF2 - Deleting User Files in Batch

SNDELUEF2 replaces SNDELUF and is used to delete user files in batch. SNDELUF?2 caters for the
extended ranges of FNR and DBID available with NaturalVersion 2.3.

Notes:

1. SNDELUEF is still available for compatability reasons.

2. When deleting user files in batch, the same JCL is used for the active user as for running trans-
actions in batch mode.

3. When user files are deleted using RJE, the batch job must have the same input delimiter as the
online session (Natural parameter ID).

> To delete user files in batch

= Issue the following command in the library SYSSN:

LOGON SYSSN
SNDELUF2 parameterl,parameter?,parameter3,parameterd,parameterb

FIN
with the parameters described in the following section.

Note: Parameters must be in delimiter mode (Natural parameter IM=D).

parameter1

DBID-FNR (N10)

Specify the physical Adabas file and database ID (DBID (N5) FNR (N5)) of the Super Natural
personal database.

parameter2

User ID (A7)

Specify the ID of the user for whom the files are to be deleted. *END indicates the end of the sequence,
*ALL indicates all users.
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parameter3

File Name (A20)

Specify which file is to be processed. blank ( ) indicatesall files.
parameter4

Status (A3)

Specify which of the processed files are to be deleted. b1ank ( ) indicates all files marked by the
user for deletion and all files with expired retention period. ALL indicates al1 files.DAT indicates
unconditional deletion of all specified data.

parameter5

User File DDM Prefix (A2)

Specify the user file DDM prefix as defined in the options (default UF).

SNSORTFI - Sorting File Links in User Profiles

The utility SNSORTFI should be used in batch mode. It sorts alphabetically the files that are linked
to a user profile so that the file list at transaction creation is displayed in alphabetical order.

This utility should be used from time to time when new files are added to a Super Natural envir-
onment and are linked with users through the file profile. In this case, the file list of the user is not
newly sorted alphabetically. Instead, the file is added to the end of the list.

Note: When a new file is linked through a user profile, the files of this user are automatically

newly sorted.

File links in user profiles are sorted by using the program SNSORTFI in library SYSSN in the form:

LOGON SYSSN
SNSORTFI
parameter
FIN
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parameter

User ID (A7)

If parameter is blank, file links of all user profiles are sorted. Parameter can be used in any of the
following forms:

NAME |[sorts file links in one specific user profile

NAM?* |sorts file links in all user profiles starting with NAM

NAMX< |sorts file links in all user profiles from the beginning until NAM
NAM> |sorts file links in all user profiles from NAM until the end
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This section describes how to define and store exit programs.

It is the administrator's responsibility to ensure that user exit programs do not have adverse effects
on Super Natural!

This section covers the following topics:

® What are Exit Programs?
® User Exits

® System Exits

What are Exit Programs?

There are two kinds of exit programs in Super Natural:

= User exits

" System exits

User Exits

User exits can be invoked from up to ten places within a transaction at run time. The user defines
which exits he wants to use, the location and any parameters. An exit can be any of the following:
® Subprogram invoked by CALL statement

* Natural program

* Natural subprogram

® Natural subroutine

® Natural map

User exits which are Natural objects must be stored in the steplib SYSTEM or in the current user's
private library.

Super Natural recognizes the exit type and automatically generates the relevant Natural statements
such as FETCH RETURN, CALLNAT or PERFORM and passes parameters.

| Note: You can prevent the modification of exits in transactions in a public library or in

transactions which will be used as a superfile using the LOCK command.
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Writing User Exits
When you are writing a user exit program, consider the following points:
Program Type

An exit program must be one of the following:

" An external program (e.g., COBOL or ASSEMBLER subprogram) callable by a Natural CALL
statement.

Or:

" One of the Natural object types listed in the previous section.
Parameters

Parameters must correspond with the call of the external program as used in the CALL statement;
or with the parameter list used in the Natural module

If the exit program requires parameters, the user must specify them manually using the Exit
Specification function.

Connecting User Exits to a File

~ To connect a user exit program with a file
= Change the file options as described in the section Exit Specification in the section Files.
Informing Users

Do not forget to provide the users with the program names of the user exits available to them, and
tell them which parameters are to be passed to the subprogram.

Storing User Exit Object Modules

Natural Objects

The object modules ofNatural programs, subprograms, subroutines, or maps can be stored as
follows:

* In the steplib SYSTEM (FUSER or FNAT) - all users of Super Natural can access these modules
from their private libraries and from any common library. This is recommended in most cases.

Or:
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In the private Super Natural libraries of selected users - only the selected users can use these
user exits. IfSuper Natural is running under Natural Security, the private library of each of the
selected users must be defined to Natural Security.

Or:

*® In the appropriate common library if the transaction from which the module is called is either
executed in a common library or was added in a common library.

| Note: When you copy a transaction which uses user exits, you must make sure that the user

exit object modules are available in the target environment as described above.

Non-Natural Programs

For information on storing object modules of external (non-Natural) programs, contact your Nat-
ural administrator or see the Natural documentation.

System Exits

You use system exits to take control at a certain point in Super Natural. The following system exits
are supplied with Super Natural in source code:

ENTRY Program invoked as entry routine for the Super Natural session.
EXIT Program invoked as exit routine when the Super Natural session is terminated.
SHEXIT Program which takes over if the user presses.

SNERRU Program invoked by error routine SNRTE. SNERRU can be modified to handle specific
error conditions. For example, you can use SNERRU to give the user additional inform-
ation or instructions when an error occurs.

SPRJEU  Natural subprogram which is executed once for every job card prior to the submission
of a batch job.

SPPARM Subprogram to define environment specific parameter settings. Parameters include:
The submission indicator for batch job submission (RJE or NPR).
Com-plete hardcopy support - default printer number generation or prompting for
destination (default).

Common library prefix character - only change at installation.
Layout prefix character - only change at installation.

You can modify these user exits if required.
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This section gives you technical information on how Super Natural processes data. This technical
information is intended to help you increase the performance of Super Natural, estimate resource
requirements and tells you how to work with certain profile settings.

This section covers the following topics:

® Super Natural and Natural

® Data Selection and Performance

® Sort

® Personal Database

® System Limits

® Error Logging

®* DDM Check on Modify

® Status Reports

= RPC Service

® Memory Requirements

® Communication with Other Applications
® The Technical Information Function
® Layout Members

® Passwords and Cipher Code

® User Profile, Option and Adabas Password Hierarchies

Super Natural and Natural

Programs

The transaction is the major part of Super Natural. Users define transaction specifications using
the menu-driven user interface and Super Naturalgenerates a Natural program from the transaction
specification.

The Natural programs generated from Super Natural transactions are saved, cataloged and run
by Natural commands like any other Natural program. One of the advantages of this is that Predict
Xref data (active cross-references) can be created automatically.

] Note: If you use Natural Optimizer Compiler, optimized object code is generated.

In order to generate source code flexibly, Super Natural still generates code with Reporting Mode
syntax. This however does not effect performance negatively.
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Each Natural program generated from a Super Natural transaction has a block of commentary
lines before the source code. The size of the commentary line block depends on the transaction
specification.

As opposed to source code which is only relevant at the time of compilation, the block of comment-
ary lines contains all the information necessary for Super Natural about the program which is to
be generated and may not be modified under any circumstance.

The Natural ESIZE required for a transaction depends mostly on the number of fields contained
in the DDM used. Information on each field contained in the DDM is stored in the ESIZE. The
most efficient way of minimizing the ESIZE requirement is to minimize the number of fields in
each DDM. The user can also physically remove the fields not needed for a transaction from the
source area before running a transaction using the RELEASE command. The fields removed are no
longer available for that transaction.

Libraries and Prefixes

The Natural objects which are created (programs in source and object code) are stored in Natural
libraries belonging to Super Natural. The names of these libraries are composed of an internal
prefix and a library ID. There are three types of Super Natural library which are distinguished for
administration purposes by an internal prefix:

" Private
Belong to one user. The library name consists of an internal prefix and the user ID.

® Public
Created by the administrator copying objects into them. Only the administrator can copy objects
into a public library. Can be used by all those who have the same public library prefix.

" Common
Can be used by all users. Users can copy objects into a common library. In order to prevent users
creating common libraries at will, the administrator must name each common library the user
can use.

Within each library the different object types and transaction layouts are distinguished by their
individual prefixes. For example, all transactions begin with the prefix I (modifiable) followed by
the user-defined transaction name and have a layout with the same name but with the prefix L
(can only be modified in SPPARM during installation).
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Natural Security Considerations

The libraries used by Super Natural need not be defined to Natural Security. This means that you
do not have to define all private files both to the application SYSSN and to every Super Natural
library. As soon as Super Natural is active, the security profile of the application SYSSN is valid
for all Super Natural libraries.

| Note: The profile of SYSSN should be set up so that the application is people protected and
Command Mode is Allowed.

When generating a prototype program or using the Super Natural Report Destination EDITOR,
a user could write programs to access all files defined to SYSSN. To prevent this, Natural performs
an additional security check of the user's Super Natural profile. If the user is not authorized to
access the current file, he receives Natural Security messages.

System Components

The Super Natural Processor consists of three components:

® Interaction
" Generation

® Execution of program generated
Interaction

All user entries are written to the Natural source area or to the side source buffer using Assembler
subprograms. Most database access takes place for the following:

* Displaying object lists

® Reading the DDMs used in the transaction

® Displaying system messages and error messages

® Displaying Precict information

® Notepad function

" Values function

= Count function
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Generation

During generation, processing takes places directly in the source area and all relevant information
is read from the internal code table and converted to the relevant Natural notation.

Execution

After generation, the execution can be done in conclusion with the generation or as a single com-
mand.

The following Super Natural commands can be issued:
" SAVE: When the SAVE command is issued in Super Natural, the following Natural commands
are executed:
" RENUMBER
" SAVE
" CATALOG

® RUN: When the RUN command is issued in Super Natural, the following Natural commands are
executed:

" RENUMBER
B SAVE

= CATALOG
" EXECUTE

" EXECUTE: When a transaction is executed from the Transaction list, the following Natural com-
mand is executed:

" EXECUTE
The Natural object is executed but not regenerated, saved and cataloged.

| Note: If you issue the EXECUTE command when the database has been modified since

the transaction was run, or if data maintenance has taken place, your results will not
be up to date.

" KEEP: When the KEEP command is issued in Super Natural, the following Natural command is
executed:

® SAVE

Only the transaction specification (commentary lines) is saved and the transaction program
is not generated. You cannot execute a transaction having just issued the KEEP command.
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DDM Field Names
Do not use Natural key words as field names in DDMs to be used by Super Natural.
Natural Profile Parameters

It is recommended that all users of Super Natural have the same Natural profile parameters.

If you run a transaction which was created under a different Natural profile to yours, you may
receive errors. Problems may occur if, for example the global parameters Decimal Character or
Control Character are different for users of the same common library.

Data Selection and Performance

READ statements take priority over FIND statements for database access. Whenever the selection
criteria allow, the query is realized using a logical sequential read. The FIND statement is only used
for complex selection criteria or when a logical sequential read is not possible.

Examples:

descriptor>value |Cannot be realized using a logical sequential read and results in a F IND statement.

descriptor>=value |Results in a READ statement

If you use fields which are not descriptors in a query, post selection using a WHERE clause takes
place.

The number of single selection criteria as well as the authorization to use non-descriptors can be
determined by the administrator in a user's profile. The administrator can also determine whether
a user may read a file physically.

| Note: The above does not apply when using SQL-SELECT statements.

Post selection in user-defined logical condition statements is realized using the keywords ACCEPT
and REJECT. This means that dependent on the result of a computation, a record which has been
read can be either used in further processing or rejected.
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COUNT Function

This function counts the number of records found by the current selection criteria using the FIND
NUMBER statement where possible. The FIND NUMBER statement cannot be used in the following
cases:

= if the database management system doesn't allow it

" non-descriptors are used

® for the primary file when files are linked.
VALUE Function

This function results in a HISTOGRAM statement using a descriptor value and can only be used if
the data storage system supports it.

Performance Considerations for Mixed Format Calculation Expressions

How to achieve optimum performance when using mixed format expressions:

" Use packed format (P) for business arithmetic. The number of decimal digits in all operands
should agree where possible.

® Use floating point format (F) for scientific arithmetic.

® Avoid mixed format expressions. In expressions where formats are mixed between numeric (N,
P) and floating point (F), data is converted to floating point format. The conversion between the
formats numeric and floating point results in considerable CPU load.

Sort

Super Natural sorts as follows:
® Database sort (if supported)

Or:

® External sort or operating system sort.
The database sort is used when a sort using up to three descriptors or a non-descriptor is required.

If a sort using more than three descriptors or a non-descriptor is required, a Natural SORT statement
is generated. The SORT statement initiates an external or operating sort depending on your envir-
onment.
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A SORT statement is also generated if a post selection for the ACCEPT and REJECT keywords in logical
condition statements is required together with system functions. This prevents rejected records
being used in control break processing and for the system functions.

The authorization for both types of sort is separate for online and batch processing.
SORTSZE

Super Natural uses the Natural SORT statement when a transaction program is generated to sort
the display fields into the order required. Because the memory necessary for this cannot be allocated
until the SORT statement is performed, run time errors (NAT0910, NAT1202) may occur if the value
of the Natural SORTSZE parameter is larger than the total memory capacity available.

A minimum value of 10KB (the Natural default value) is sufficient for internal sorts.

Personal Database

The personal database consists of one or more physical Adabasfiles. Each user works on one file
which is determined in his profile. The number of the Adabas file is given to Natural when the
user logs on to Super Natural which means that the Natural LFILE parameter is not needed.

Each physical Adabas personal database file has a Master DDM which describes how many
descriptors and elementary fields of which format and length are available for user files.

The Master DDM describes the following:

Control field AA

® Numeric descriptors

Alphanumeric descriptors

® Numeric fields

Alphanumeric fields

The descriptors identified in the Master DDM are defined with different lengths and the elementary
fields are defined with a length of 1. All fields except for AA and CA are defined with null-value
suppression.

The physical definition or Field Description Table (FDT) consists of the following:

* Internal control field AA(NS)
® Numeric fields (not in packed format)
® Alphanumeric fields

® Binary superdescriptors
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® Alphanumeric superdescriptors

The superdescriptors identified in the FDT consist of the field AA and a descriptor identified in
the Master DDM. Because of this, the length of the descriptors in the Master DDM is predefined.

When a user file is created, a DDM is generated according to the user input. All the descriptors
required are identified with an Adabas field reference in the Master DDM according to their length.
Descriptors in the user file can be shorter but not longer than their counterpart in the Master DDM.
All elementary fields are created with the length required as these can be dynamically extended
by Adabas.

The non null-value suppressed descriptor CA is used to guarantee that all data (including zero in-
formation) in a user file can be retrieved. CA must be present in every user file. When a Natural
program accesses a user file, the Natural descriptor access is converted to access via the corres-
ponding superdescriptor. This means that users can only perform a READ PHYSICAL on his own
user files using the default descriptor CA. This allows data from different user files to be kept sep-
arate.

User files can also be processed directly from Natural but the associated DDM may not be modified.

User files are defined as private files in Natural Security and automatically linked to SYSSN. Super
Natural users may not use each other's user files unless the administrator authorizes them to.
Users and administrators cannot copy transactions with Destination USER FILE.

Because of the interdependency between the DDMs and the data in the personal database, the
following conditions must be fulfilled if you want to move them to another physical database:

® The Master DDM must be cataloged with DBID=0

® The Personal Database must have an Adabas file number which can also be used in the new
environment

The Personal Database is also used to store Notepad data, runtime error information and inform-
ation of the DDM Check on Modify functionality.

For an overview of the Personal Database, see the following diagram:
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System Limits

The maximum number of possible field references within Super Natural is 676 per default.

To satisfy special requirements this limit can be enhanced up to 1196 field references by setting
the following system option. The limits mentioned, include all fields of a transaction: primary,
secondary, lookup, user-defined fields and system variables.

~ To use the extended number of fields
1 Open the module SPPARM in library SYSSN with the program editor.

2 Switch the option "XL" (extra large number of fields required) on.

FIELD_REF_XXL="YES'
Now Super Natural allows to process up to 1196 fields within a transaction.

| Note: With this enhancement, the unique Super Natural field references consist of alpha

and numeric characters together, for example, A0 --> A9 and 0A -->9Z. This system option
is valid for the entire Super Natural system.
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Error Logging

The Error Logging facility allows you to store environment information at the time of your error
directly and without a delay.You can use the program SNELOG, stored in the Super Natural library
SYSSN, to maintain the logging utility and review runtime errors. Error Logging is designed to
report Natural System Errors.

This section covers the following topics:

® Possible Errors

® Listing Error Reports

® Showing Error Reports

® Deleting Error Reports

® Printing Error Reports

® Maintaining Error Reports
® Migrating old Error Reports

If you want to view the Error Logs you have to activate the Error Reporting in SNELOG in the
library SYSSN.

Possible Errors

The following errors are not user errors but may occur for one of the following reasons:

Cause Cure

System parameters are set too low (SORTSZE, printer size etc.) |Change system parameters

Response codes from DBMS e.g. (NAT3009) Inform users e.g. using system user exits
Syntax errors due to incorrect Super Natural code generation |Inform Support

System errors due to incorrect Super Natural routines Inform Support

Listing Error Reports

If you want to view the Error Reports you have to activate the Service-Routine SNELOG in the
Library SYSSN.

> Invoke List of Error Reports

= Invoke the Service-Routine SNELOG out of the library SYSSN.

The following screen appears:
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17:02:54 T Super Natural =S 2000-06-21
- Error Reporting and Analization - MELOGI1

Code Function
L List Error Reports

D Delete Error Reports
M Maintain Error Reporting
?

Help
Exit
Code ..o, _
Library ........... 2
Program Name ...... *
Date Time ......... 2000-06-21 *

YYYY-MM-DD HH:II:SS.T

Personal DB DBID .. 167__
Personal DB FNR ... 93_

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
HELP Exit Canc
AAA 14,024

Field Descriptions

Code
The following function codes are possible:
® L:Lists all Error Reports of the according selection criteria, consisting of Library, Program Name

and Date / Time.

® D: Deletes all Error Reports of the according selection criteria, consisting of Library, Program
Name and Date / Time.

® M: Maintains Error Reporting.
® ?: Provides help concerning the Error Reports.

= : Terminates the Function.
Library

Choose the library which Error Report you want to display. There are three ways to enter the
Library Name:

® Enter the complete Library Name.

= Enter a *.
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® Enter a part of the Library Name with a Wildcard (¥,<,>).
Program Name

Choose the transaction whose Error Report you want to display. You can enter the program name
as described above.

Date Time

Choose a Date / Time to display an Error Report. You can enter the Date / Time as described above.
The List Error Report Screen appears with the set of Error Reports according to your selection.
Personal DB DBID / Personal FNR

= Specify the database ID (DBID) and the file number (FNR) of the personal database whose logging
list you want to display. The default DBID and FNR depend on the setting of the parameter
LFILE.

List of Error Reports
17:35:20 x*xx*x% Syper Natural ***** 2000-06-21
- List Error Reports - MELOGZ21
Cmd Date/Time Err-No Library Program Line Stat User-1ID
2000-06-21 * W * *
_ 2000-06-21 15:50:23 3055 YPOR ILIST 0860 O POR
2000-06-21 16:59:17 0082 YPOR TERROR 0350 O POR

Cmd's are S (Show), D (Delete), P (Print)

You are on the last page

EMc@r=PEL===RF2===P[Fg= == PFil= = = PEE = = = P[EG= = =PIF7 = = =[P[Ee= = = P[FC)= = = PFIL0)= = P[Fil1l = = P[Fil 2= ==
Exit == 4 Canc

Administration 157



Technical Information

Navigation

- To move Up / Down

1 Use Pr6 to move to the first page.

2 Use Pr8 to move one page forward.

~ To Exit/ Cancel
m  Choose Exit or Cancel to leave the transaction list and reach the Error Report main screen.
Commands

Choose the required Error Report. There are three ways to process the Error Reports:

® Show: The selected Error Report is shown. For further information, see Showing Error Reports.
" Delete: The selected Error Reportis deleted. For further information, see Deleting Error Reports.

® Print: The selected Error Report is printed. For further information, see Printing Error Reports.
Field Descriptions

Date / Time

Date / Time, when the error occurred and the Error Report is written. You can enter the Date /
Time as described above.

Error-Number

Shows the number of the error that has occurred. You can enter the Error-Number as described
above.

Library

Name of the library where the error occurred. You can enter the Library as described above.
Program

Program that did flag the error. You can enter the Program name as described above.

Line

The line number in the program where the error was identified.

Status

Additional information on the kind of error.
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User-ID

User ID of the person who received the error. This information can be suppressed if desired (see
section Maintain Error Reports). You can enter the User ID as described above.

Showing Error Reports

~ To show the Error Report

= Enter S to show the Error Report.

A window appears where the most important information concerning the error is displayed.

17:51:44 xAFx*x Syper Natural ***** 2000-06-21
- Show Error Report - MELOGA1

Error occurred at .. 2000-06-21 16:59:17 with UserID ........ POR

Error Number ....... 82 in Library ......... YPOR

Error Program ...... TERROR / Line .. 350 with Error Status .. O

Message Text:
Invalid command, or Subprogram NIX-DA does not exist in Tlibrary.

------------------------- Environment Information ----------------------------
Device Type ....... PC Operating System .. MVS/ESA

TP Monitor ........ COMPLETE
Product Versions:

Super Natural ... 3.3.1 System Files (DBID,File):

Natural ......... 3.1.3 PersonalDB ...... (167,93)
Predict ......... 4.1.1 FNAT ... .. ... .. (167,30)
CON-NECT ........ 0.0.0 FUSER ........... (167,32)
AOS ... ..l 0.0.0 FSEC ... .. ..... (167,30)
NSC ... 0.0.0 FDIC ............ (167,15)

You are on the first page
Enter=PFl===PF2===PF3===PFl===PF5===PFG===PF7 ===PFE===PFY===PFLlO==PFLll==PF12===
Print Exit + ++ Canc
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Navigation

> To print

Enter Print (or PF2).

~ To move Up / Down

1 Use Pr6 to page to the first page.

2 Use Pr8 to page one page forward.

> To Exit / Cancel

s Choose EXIT or CANCEL to leave the report and reach the Error Report List screen.
Error Report Descriptions

General Description

18:20:27 aaraas SlperSNaEUiRalissaaa 2000-06-21
- Show Error Report - MELOG41

Error occurred at .. 2000-06-21 16:59:17 with UserID ........ POR

Error Number ....... 82 in Library ......... YPOR

Error Program ...... ITERROR / Line .. 350 with Error Status .. O

Message Text:
Invalid command, or Subprogram NIX-DA does not exist in Tibrary.

©

Listing of the major information at the time when the error occurred:

Field Description

Error occurred at|{Date / Time when the error occurred.

Error Number |Error-key

Error Program |Program that did flag the error.

Line Program line where the error was found.

Message Text Text, that informs about the error reason.

User ID User ID that received the error.
Library Library name where the error occurred.
Error Status The following entries are possible:

® C (Command Processing Error)

® L (Logon Error)
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Field Description

® O (Object Time Error)
® S (Non-correctable Syntax error)

® R (Error on Remote server (in conjunction with Natural RPC)

® Press PF8 for more information.

Environment Information

10:19:19 aaraas SlperSNaEUiraliisaaa 2000-09-20
- Show Error Report - MELOG41

Error occurred at .. 2000-07-20 11:45:08 with UserID ........ =

Error Number ....... 932 in Library ......... NEWSN

Error Program ...... SN1110 / Line .. 1510 with Error Status .. O

Message Text:
Program version error.

------------------------- ERYT Frenment ITRToOrmation ============================
Device Type ....... PC Operating System .. MVS/ESA

TP Monitor ........ COMPLETE
Product Versions:

Super Natural ... 3.3.1 System Files (DBID,File):

Natural ......... 3.1.3 PersonalDB ...... (167,93)
Predict ......... 4.1.1 FNAT ............ (167,30)
CON-NECT ........ 0.0.0 FUSER ........... (167,32)
AOS ... 0.0.0 FSEC ............ (167,30)
NSC ..o 0.0.0 FDIC ............ (167,15)

You are on the first page
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Print Exit + ++ Canc

Default listing of data from the error environment. This list consists of Natural environment
variables.

= Press PF8 for more information.
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Natural Parameter Information

10:19:19 xxx*x% Syper Natural *****
- Show Error Report -

Error occurred at .. 2000-07-20 11:45:08 with UserID .......
Error Number ....... 932 in Library ........
Error Program ...... SN1110 / Line .. 1510 with Error Status

Message Text:
Program version error.

Natural Parameter Information (1)

Term.Control Character (CF) .. ? 65 Limit Error (LE) ........

Decimal Character (DC) ....... . 4B Line Size (LS) ..........
Default Format (FS) .......... ON Print Mode (PM) .........
Help Character (HI) .......... ? 6F Page Size (PS) ..........
Input Assign (IA) ............ = 7JE Structured Mode (SM) ....
Input Delimiter (ID) ......... , 6B  Zero Division (ZD) ......
Input Mode (IM) .............. F Zero Printing (ZP) ......

You are on the first page

2000-09-20
MELOG41

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---

Print Exit -- - + ++

Canc

Information of Natural Parameters that are set by starting the session. Some information is displayed
additionally in HEX characters. For more information concerning Natural parameters, see the

Natural Parameter Reference documentation.

" Press PF8 for more information.
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10:19:19 raint Siforee NEIEUIREN ] sty 2000-09-20
- Show Error Report - MELOG41

Error occurred at .. 2000-07-20 11:45:08 with UserID ........ =

Error Number ....... 932 in Library ......... NEWSN

Error Program ...... SN1110 / Line .. 1510 with Error Status .. O

Message Text:
Program version error.

Natural Parameter Information (2)

Max. CPU Time (MT) ........... 6000 Automatic LOGON (AUTO) ....... OFF
Max. Program Calls (MAXCL) ... O Database Updating (DBUPD) .... ON
Nat. System Commands (NC) .... OFF Date Format (DTFORM) ......... I
Wait on Hold (WH) ............ OFF

Processing Loop Limit (LT) ............ 99999999

Max. DBMS Calls between I0 (MADIO) .... 0

Read Only System Files (ROSY).......... OFF

You are on the first page
Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF/---PF8---PF9---PF10--PF11--PF12---
Print Exit -- - + ++ Canc

® Press PF8 for more information.
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Natural System Variables Information

10:19:19

Error occurred at ..
Error Number
Error Program
Message Text:
Program version error.

2000-07-20 11:45:08
932
SN1110

xFExx Super Natural *****
- Show Error Report -

with UserID
in Library
with Error Status

/ Line .. 1510

Natural System Variables Information
ADATA .. 0 *LOG-LS ...
*HARDCOPY ............. DAEPRTAD *LOG-PS ...
FINIT-ID ..., DAEFTCB9 *PAGESIZE ..............
*INIT-PROGRAM . ........ NAT31 *PE-KEY ... ol
AINIT-USER ... ... ... CF *PE-NAME ...............
*LANGUAGE ............. 1 *STARTUP ... ot
ALINESIZE ... ... .. ... 80 *STEPLIB ...,

You are on the first page

2000-09-20
MELOG41

MENU
SYSTEM

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---

Print Exit

- - - + ++

® Press PF8 for more information.

Canc
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Natural Stack Information

10:19:19 xxxx% Syper Natural ***** 2000-09-20
- Show Error Report - MELOG41

Error occurred at .. 2000-07-20 11:45:08 with UserID ........ -

Error Number ....... 932 in Library ......... NEWSN

Error Program ...... SN1110 / Line .. 1510 with Error Status .. O

Message Text:
Program version error.

Natural Stack Information
Stack Level 1:
Type ...... Stack Empty
Contents
Stack Level 2:
Type ...... Stack Empty
Contents
Stack Level 3:
Type ...... Stack Empty
Contents
You are on the last page
EmeEr=RIEL == o[REZ= = S PIEE = = = [PIEALS = = PIEE = = = [PIEG = = SPIIE7 = = SfpIEe= = S pIIEC) = = S RIET(0)= = [RIFILL = = PIFIL 2= = =
Print Exit == = Canc
Information on the Natural Stack status.

The Natural parameter information, the Natural system variables and the Natural stack information
can be suppressed if desired (see the section Maintain Error Reporting).

Deleting Error Reports

This command enables you to delete an Error Report.

~ To delete an Error Report

1  Enter D (Delete) beside the transaction name in the list of Error Reports.
A window appears, where you have to confirm the delete.
You can also mark multiple Error Reports to delete.

Or:

Enter D (Delete) within the Error Logging main screen and choose the desired Error Reports
out there.
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2

10:22:11

Cmd Date/Time

2000*

2000-07
2000-07
d 2000-07
2000-07
2000-07
2000-07
2000-07

2000-07-
2000-07-
2000-07-
2000-07-
2000-07-
2000-07-
2000-07-
2000-07-

Cad's are S

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---

FHEF*x Syper Natural *****
- List Error Reports -

2000-09-20
MELOG21

Err-No Library Program Line Stat User-1ID

* * *

Confirm Delete

1 Error Reports will be deleted.

Please enter 'Y' to confirm: Y

*

21

(Show),

:41:08
D (Delete), P (Print)

Exit

0932 NEWSN SN1110 1520
0932 NEWSN SNI110 1520
0932 NEWSN SN1110 1590
0261 YCF T00XX01 0010
0932 NEWSN SN1110 1590
0082 SYSSN SNREST 0000
0082 SYSSN SNREST 0000
0082 SYSSN SNREST 0000

Enter Y if you want to delete the Error Report.

The Error Report is deleted now.

Printing Error Reports

This command enables you to print an Error Report.

~ To print Error Reports

1
2

Select Error Reports to be printed.

Enter Print or PF2.

OO OO ;m O o o

PF10--PF11--PF12---
Canc

The information of the Error Report is composed on one page and printed on the printer you

have choosen.
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Maintaining Error Reports

18:10:14 *xxAFk Super Natural **xx*xx 2000-06-21
- Maintain Error Reporting - MELOG811

Code Function

E Enable Error Reporting

D Disable Error Reporting
S Set Error Reporting Options
M Migrate old Error Reports
? Help
Exit

Code .. _

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
HELP Exit Canc

These functions help you to maintain the Error Reports. They are described above because the are
prerequisites for error logging.

Enable Error Reporting

You have to enable Error Reporting in your user file to receive the Error Reports.

~ To enable Error Reporting

1 Enter E and press Enter.

The following window appears:
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10:31:24 T Super Natural =S 2000-10-05
- Maintain Error Reporting - MELOG8I1

Enable Error Logging
The Error Reporting will be enabled now.

Please enter 'Y' to confirm: Y

Code .. E

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Exit Canc

2 Enter Y and press Enter.
The Error Reporting facility is enabled
Disable Error Reporting

If you do not want to log Error Reports further on, disable this facility. All existing Error Reports
are deleted and the future occurring errors are not reported.

~ To disable Error Reporting

1  Enter D and press Enter.

The following window appears:
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10:27:53 T Super Natural =S 2000-10-05
- Maintain Error Reporting - MELOG8I1
Disable Error Logging

The Error Reporting will be disabled now
and A1l Error Reports will be deleted.

Please enter 'Y' to confirm: N

Code .. d

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Exit Canc

2 Enter Y and press Enter.
The Error Reporting facility is disabled and all stored Error Reports are deleted.
Set Error Reporting Options

This window allows you to specify how Super Natural Errors are reported.

~ To set Error Reporting options

= Enter S and press Enter.

The following window appears:
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Set Error Reporting Options

OnTine Error Display
with Error Message Text .......... N (Y/N)

Record Error Report Data

with Natural Session Parameters .. Y (Y/N)
with Natural System Variables .... Y (Y/N)
with Stack Data/Commands ......... Y (Y/N)

Store User 1D
with Error Reports ............... N (Y/N)

These options influence the online error messaging and thge date stored in an Error Report
as you define them here. You can modify them to your needs. Be aware that the options you
set here, concern your whole Super Natural system and are not user-specific.

Online Error Display with Error Message Text:
* Defines if the error is displayed online with message text or just with the error number.
Record Error Report Data with Natural Session Parameters:

" A selected number of Natural session parameters are logged with the values they have at the
time when the error occurs.

Record Error Report Data with Natural System Variables:

" A selected number of Natural system variables are logged with the values they have at the time
when the error occurs.

Record Error Report Data with Stack Data/Commands:
® The first three levels of stacked data or commands are logged.

For further information on these options, see the following Natural documentation: Installation for
z/OS, Installation for z/VSE, Installation for BS2000/0OSD, Installation for VM/CMS and Operations.

Store User ID with Error Reports

Defines if the User ID of the user who receives the error is displayed on the Error Report.
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Migrating old Error Reports

If you have Error Reports that are logged by Super Natural versions earlier than 3.3.1, they will
not be displayed with the new Error Reporting Facility. You have to migrate them to work with
them in future. The old Reports will be structured according to the new Error Reporting facility.
After the migration they are available on the List Error Report screen.

~ To migrate old Error Reports

1  Enter M and press Enter.

The following window appears:

Confirm Migration

211 Error Reports will be migrated
to new Error Report Format.

The old Error Reports will be deleted
and the old Log File will be closed.

Please enter 'Y' to confirm: y

2  EnterY.

The old Error Reports are migrated. The old Error Reports will be deleted and the old log file
will be closed. This means that the Error Reports cannot be viewed with an earlier version of
SNELOG if you use a previous version of Super Natural and the current simultaneously.

DDM Check on Modify

The option DDM Check on Modify allows you, to compare the field structure of the transaction
with the current field structure of the DDM used. The result decides wether the current DDM-
field structure can be adapted or whether no adaptation is possible.

This section covers the following topics:

® Results of Checking
® Criteria of Checking

® Change of References
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® Modes of DDM Check on Modify
® Enable DDM Check on Modify
® Phases of DDM Check on Modify

Furthermore there is the option SNTALOG to obtain a status report, where all information con-
cerning deviations is listed.

Results of Checking

The following graph shows the order of events of DDM Check on Modify.

| Note: DDM Check on Modify is only feasible, if the option DDM Check on Modify is set to
yes. This option can be set in the user-profile, file-profile and superfile-profile.

@M Check

‘ DO & £ are unchanged Ta s pro-
ot cessed

Transaction
update

TA s adaptable autorratic

ot upd ate

TA B not adaptable

no update

TAcomupt, hoonsistent
ar DO not available

o 1o Up ate

old Ta defore MSM311)

o no upd ate

RO

DDMs are unchanged

No deviations are located between the field structure of the transaction and that of the DDM. No
Status Report is written and no confirm-window is displayed.

Transaction is adaptable

Some deviations are located between the field structure of the transaction and that of the DDM,
but they are automatically adaptable. A Status Report is written (if activated) and the confirm-
window is displayed.

Transaction is not adaptable

Some deviations that are located between the field structure of the transaction and of the DDM,
that cannot be adapted automatically. A Status Report is written (if activated) and the confirm-
window is displayed.
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Transaction corrupt, inconsistent or DDM not available

The transaction is detected as corrupt or inconsistent or not all DDMs used are available. A Status
Report is written and a confirm-window is displayed.

Old Transaction

The transaction cannot be processed, because it was developed with a Super Natural Version before
- 311. First the transaction has to be migrated separately without the option DDM Check on
Modify. Then it can be adapted. No Status Report is written, but a confirm-window is displayed.

Criteria of Checking

All transaction that use Data Selection = Full ScreenorData Maintenance Types (Add,
Update etc.) are checked with the option DDM Check on Modity.

Exeption:
Transactions that use other data selection modes ignore the option DDM Check on Modify although
they use lookup files.

Fields checked

Primary / Secondary Files| All fields of the new DDM are loaded into the transaction. A comparison is made
only between the fields of the Transaction and the DDM-Structure that are listed
in the worksheet of the transaction. The remaining fields are updated without a
DDM-fieldstructure check.

Lookup Files Only used fields selected in the transaction are loaded from the DDM and
compared with the transaction fields.

User Fields User fields and system variables are only checked to see if the field reference has
changed.

What Field Properties are Checked?

Fieldname and Criteria of comparison between the new structure of the DDM and the structure
Filenumber of the transaction. Fieldname and filenumber must be identical (primary file must
be 1, secondary file must be 2, lookup file must be 3 or higher).Otherwise it is
assumed that the field is deleted.

Database-Reference If the Database-Reference has changed (if it exists) the field cannot be allocated
any more.

Format A change of format is an essential change that can cause errors by processing the
transaction.

Level A change of level indicates that the field is assigned to another group or that is
no longer assigned to any group.

Length If the length decreases, the values that were assigned to that field, may not fit any
more.
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Decimal-Places If the length decreases, the values, that were assigned to that field, may not fit
any more.
Descriptor Type A change of the descriptor type indicates that a field obtains a different meaning

within the DDM. Possible meanings: Super-Descriptor, Sub-Descriptor,
Phonetic-Descriptor or Non-Descriptor.

Array Type A change of the array type indicates that a field obtains a different occurrence
within the DDM. Possible meanings: Array, Multiple, Periodic, Multiple in
Periodic, Elementary Field.

Change of References

New Fields in the DDM

If new fields join the DDV, the transaction field-references are moved. All following database
fields, system fields and user fields get new references. These changes will be updated automatically
in all functions of the transaction.

Deleted Fields in the DDM

If fields in a DDM are deleted, transaction field-references are moved. These new references are
updated in all functions of the transaction.

Modes of DDM Check on Modify

A transaction check can lead to the following results:

" no update possible
" automatic update is processed

" transaction is processed without update
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Mo update possible

Transaction update pozzible I—

transzaction carrupt

General ermor |—

—‘ Db not available |

Errar

—‘ Tranzaction inconzistent |

—‘ Fizld used & notidentifiable. Filename and file number have to be identical.

—‘ [Database-Reference has changed. |

—‘ Format has changed.

—‘ Array-Type has changed. |

—‘ Lirk field for a lookup file key field is not identifiable.

Length has decreased.

—‘ Decimal places have dacreasead. |

—‘ Dezcriptor twpe has changed. |

—‘ Fizld=elected, but not uzed Cin the worksheet) i not identifiable.

—‘ Fizld-Feference has changed. |

Lewel haz changed.

—‘ Irformation I——‘ Length has increased. |

—‘ Decimal places have increased. |

—‘ Lookup file fizld, not uzed and notselected, i not identifiable.

| Transaction update processed | Successfulty updated

Enable DDM Check on

Modify

The option DDM Check on Modify is set in the Maintenance section of Super Natural. The place
where the option is set decides the consequences:

user profile all transactions of this user will be checked

file profile all transactions of all users, that use this file as primary- or secondary file, will be checked

super-file profile |all transactions will be checked, that use this super-file

The following section describes, how you can proceed a transaction in spite of a changed DDM.
However this update is not possible, if a General Error or an Error (see Verification-Level) appears.

Phases of DDM Check

on Modify

The functionality is divided into two phases:

1. Get the current DDM field-structure, compare it against the transaction field-structure and
identify differences.

2. Update the references in the functional parts of the transaction. The updated field-list is provided

in the worksheet.
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Update possible

The following window appears:

fPeoccocooocosooooos CONTIFils=c==cc=cs=cc=coos +
! Changes in the data structure of one or !
I more files used in the transaction are !
I detected. !
_ Update Data Structure(s) !
and Enter Worksheet !
|

|

|
!
! _ Leave Transaction
|

~ Proceed the transaction-update

1 Choose the option Update Data Structure(s) and Enter Worksheet.

The worksheet of the transaction appears.

2 Choose the option Leave Transaction if you do not want to proceed with the transaction
Now.

The update of the data structure(s) is canceled. A Status Report (if enabled) is written.
Conclude DDM Check on Modify

® If you conclude the transaction with keep, save or run the updated field-description is saved
into the transaction.

® If you abandon the transaction with cancel or menu, the transaction is dropped.
No Update possible

No Update is possible if the DDM is changed so, that a system error or an error (see Modify-Options)
occurs. The following screen will be displayed.
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L LELELELELEL LR CONTTFlle===c=c=c=cscscsco +
! Changes in the data structure of one or !
I more files used in the transaction are !
| detected. !
! The differences between the former and !
! the current data structure can not be !
! resolved automatically.

| |
| |
| |

_ Leave transaction

> To leave the transaction

n Choose Leave Transaction.

A Status Report (if enabled) is written. It gives the reason for not updating the transaction.

Change Transaction Manually to enable the Update

~ Change Transaction manually to enable the update of the data structure

1 You may switch off the option DDM Check on Modify.

2 Enter the transaction and remove the field usage that prevented the automatic update according
the information provided within the Status Report (in enabled).

3 Modify the transaction again with the option DDM Check on Modify.

Status Reports

This section covers the following topics:

® Displaying Status Reports

® Browsing Status Reports

® Deleting Status Reports

® Printing Status Reports

A Status Report describes the Status of a transaction concerning the changed DDM. For each
transaction that was modified using the option DDM Check on Mod1ify, one Status Reportis provided.

It contains the current status of the transaction and shows finally, whether the transaction was
successfully updated and if it was saved with the new DDM field structure.
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If you want to view the Status Reports you have to activate the Service-Routine SNTALOG in the
Library SYSSN. Further information, see the Installation and Set-Up documentation.

Displaying Status Reports

You can display the current Status Report out of a list of all available Status Reports.

~ Invoke List of Status Reports

= Invoke the Service-Routine SNTALOG out of the library SYSSN.

The following screen appears:

11:32:21 RS SUper Natural = 1999-04-16
- Transaction Status Reports - MTALOGI1

Code Function

L List Transaction Status Reports
D Delete Transaction Status Reports

? Help
Terminate
Code .............. L
Library ........... ypor____ (with library prefix)
Transaction Name .. I* (with transaction prefix)
Date Time ......... 2

YYYY-MM-DD HH:II:SS.T
Personal DB DBID .. 167__
Personal DB FNR ... 93_

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
HELP Exit Canc
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Field descriptions

Code

The following function codes are possible:

L Lists all Status Reports of the corresponding library.

D Deletes the marked Status Reports.

? Provides help concerning the Status Reports.

=  Terminates the function.
Library

Enter the library name with the associated prefix. A prefix is always placed in front of the library
name. There are three ways to enter the library name:
® Enter the complete library name.

® Enter * (the List Transaction Status Report Screen appears where you can choose the appropriate
Status Report).

® Enter a part of the library name with a wildcard (*,<,>).
Transaction Name

Choose the transaction whose Status Report you want to display. For the way to enter the transac-
tion name see the description above.

Date Time

® Choose a Date / Time to display a Status Report. You have three ways to enter the Date / Time:
* Enter the complete Date / Time (YYYY-MM-DD HH:IL:SS.T).

* Enter * (the List Transaction Status Report screen appears where you can choose the appro-
priate Status Report).

* Enter a part of the Date / Time with a Wildcard (¥,<>).
Personal DB DBID / Personal FNR

" Specify the database ID (DBID) and the file number (FNR) of the personal database whose logging
list you want to display. The default DBID and FNR depend on the setting of the parameter
LFILE.
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List of Status Reports

14:05:27

Cmd Library Program Date/Time

* * *

CSAMPLE IOTESTO3 1999-04-29 14:57:20.0
CSAMPLE IOTESTO5 1999-04-28 17:35:30.4
YCF TAAAAA 1999-04-30 15:28:46.2
YCF TAAAL 1999-04-23 13:50:15.6
YCF TAAA2 1999-04-23 15:08:43.3
YCF TAAA3 1999-04-23 15:11:17.2
YCF TAAAL 1999-04-23 15:13:13.5
YCF IAABC 1999-04-29 14:37:07.3
YCF TAAB11 1999-05-03 16:57:17.8
YCF IAAB4 1999-04-29 14:37:48.8
YCF TAAB4SEL 1999-04-29 14:41:25.3
YCF ITAAB5SEL  1999-05-03 16:56:58.6
YCF IASDF 1999-05-17 11:36:20.6
YCF INEU3 1999-05-10 13:34:38.4
YCF INEU4 1999-05-10 10:57:45.6

xxxFE Super Natural **x**
- List Transaction Status Reports -

Cad's are B (Browse), D (Delete), P (Print)

Level
*

i e T B W o B T o B o e o O e B

1999-05-28

Status

Reference
Reference
Reference changed
Reference changed
Successfully updat
Successfully updat
Successfully updat
Length less

Length greater
Successfully updat
Successfully updat
Not ident.(used)
Length less
Reference changed
Successfully updat

changed
changed

MTALOG21

User-1D

-QE
-QE
CF
CF
CF
CF
CF
CF
CF
CF
CF
CF
CF
CF
CF

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---

Navigation

Exit

- To move Up / Down

+

Canc

1 Use Pr6 to move to the first page.

2 Use Pr8 to move one page forward.

~ To Exit/ Cancel

s Choose Exit or Cancel to leave the transaction list and reach the Status Report main screen.
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Commands

® Choose the required Status Report. There are three ways to process the Status Reports:

" Browse: The selected Status Report is browsed. For further information, see Browsing Status
Reports.

" Delete: The selected Status Report is deleted. For further information, see Deleting Status
Reports.

® Print: The selected Status Report is printed. For further information, see Printing Status Re-
ports.

Field Descriptions

Library

Name of the library where the Status Report is stored.

Program

Transaction name of the associated Status Report.

Date / Time

Date / Time, when the transaction is processed and the Status Report is written.
Level

Possible levels: finished, information, warning, error, general error.

Status

This field shows detailed information of the reason why the Status Report was written. The worst
case is displayed.

User-ID

User ID of the person who has processed the transaction.
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Browsing Status Reports

~ To browse the Status Report

Enter B to browse the Status Report.

A window appears where the most important information of the processed Transaction with
changed DDM is displayed.

13:40:15 T Super Natural =S 1999-04-28
- Browse Transaction Status Report - MTALOG31

Transaction ..... 1Z02CRU Verified at .. 1999-04-28 13:33:46.7

Library ......... YPOR by .. POR

Warning ......... Length Tless

Primary File .... -QE-TST-21

Secondary File .. -QE-TST-24

Cmd Field Verification Field Name Field Type Format

_  Length Tless START-TIME Primary N 3

_  Reference changed ID-YACHT Primary N 8

_  Reference changed CHARTER-CRUISE Primary Group

_  Reference changed ID-CONTRACT Primary P 6

_  Reference changed START-DATE-DESTINATION Primary A 49

_  Reference changed YACHT-1D Secondary N 8

_  Reference changed YACHT -NAME Secondary A 30

_  Reference changed YACHT-BRANCH Secondary Al

Cmd is S (Show Details)

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---
Print Exit == 4 Canc

Navigation

~ To print

Enter Print and the current Status Report is printed.

The Status Report is printed.

~ To move Up / Down

1

Use PFé to page to the first page.
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2 Use Pr8 to page one page forward.

> To Exit/ Cancel

m  Choose Exit or Cancel to leave the transaction list and reach the status report list.

~ To Show Details

1 Select the field of the transaction you want to get further information about and enter S (show
details).

To view multiple fields in detail:
2 Mark the required fields with S.
3  Press Enter.

4  Page through the selected field descriptions with PF3.

After you have paged through all field descriptions, you again reach the browse screen.
Status Report Descriptions

Transaction

Name of the current transaction with prefix.

Library

Name of the library with prefix, where the transaction is saved.
Finished / Information / Warning / Error / General Error

Finished / Information / Warning / Error / General Error are possible status of the transaction. This
tield shows detailed information of the reason why the Status Report was written. The worst case
is displayed.

Primary File

Name of the primary file

Secondary File

Name of the secondary file if defined.
Verified at ... by

Date / Time when the transaction was accessed last with the option DDM Check on Modify and
user ID, which performed the DDM check.
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Note: Further field descriptions see show details.

~ To view the detailed description of single fields of the transaction

Enter S (show details).

You receive a detailled description of the choosen field.

Note: You can choose multiple fields simultaneously.

13:42:14

Transaction ..... [7202CRU
Library ......... YPOR
Warning ......... Length less
Primary File .... -QE-TST-21
Secondary File .. -QE-TST-24

Detail Information for Field ID-YACHT
Verification Reference changed

Field Type ........ Primary
Format ............ N 8
Descriptor Type ... Descriptor
Array Type ........

Field Reference ... AL

DB Reference
Linked with File ..

xFxxx Super Natural x***x*
- Show Transaction Status Report -

1999-04-28
MTALOG41

Verified at .. 1999-04-28 13:33:46.7
by .. POR

In Use with ---
Link Field

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---

Print Exit

Navigation

~ To print

Enter Print.

The current Status Report is printed.

- To cancel

Canc

Choose Cancel to leave the Show Details screen and reach the browse screen immediately.
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> To exit

s Choose Exit to page through the selected field descriptions (if you have chosen multiple
fields). After you have paged through the field descriptions, you reach the browse screen.

Detail Information for a field

Verification

Result of DDM Check on Modify: reason for reporting for a field.

File Type

The following entries are possible:

" primary file

" secondary file

lookup file
" system variable

® dynamic input field
Format
Field format and length.

Descriptor Type

The following entries are possible:

" empty

*® descriptor

" super-descriptor

® sub descriptor

® phonetic descriptor

® hyper descriptor
Array Type
The following entries are possible

" empty
® periodic group

* multiple field

Administration
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* multiple field within a periodic group

Field Reference

Unique Reference (two letters) of this field within the transaction. The reference before DDM

Check on Modify is shown.

DB Reference

Adabas database reference.

Linked with File

Filename of the lookup file, which is linked with the current file.
In Use with

List of transaction functions where the current field is used.
Possible functions are:

® Display

= Control Break

" Redefinition on Field
® Interfield Arithmetic
® System Function

= Selection

® Calculation

" Logics

® Tabular

® Graphics

® Layout (report)

" User Exit

® Link /Join Field

= Connect Text Link
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Deleting Status Reports

This command enables you to delete a Status Report.

~ To delete a Status Report
1  Enter D (Delete) beside the transaction name in the list of Status Reports.
A window appears, where you have to confirm the delete.

You can also mark multiple Status Reports to delete.

| |
! Delete Transaction Status Report IZ02CRU !
! of Tibrary YPOR !
I Please enter "Y' to confirm: N !
| |

2 Enter Y if you want to delete the Status Report.

The Status Report is deleted now.
Printing Status Reports

This command enables you to print a Status Report.

~ To print a Status Report

1  Enter P (Print) beside the transaction name in the list of Status Reports.
A window appears, where you have to confirm printing.

You have also the possibility to mark multiple Status Reports to print.

| |
I Print Transaction Status Report IZ02CRU !
! of Library YPOR !
! PTease enter 'Y' to confirm: N !
| |
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2 Enter Y, if you want to print the Status Report.

The Status Report is printed now.

Super Natural RPC Service Functionality

This section covers the following topics:

® Introduction

" Hints and Limitations

® Dynamic Input Fields within the RPC Service
® Generate an RPC Service (Server Side)

® Resulting RPC Service Source

® Create the Client Side Parameters
Introduction

Remote procedure call (RPC) techniques establish a framework for communication between
server and client systems that can be collocated on the same computer or based on a network of
identical or heterogeneous machines and operating systems. The Natural RPC facility enables a
client Natural program to issue a CALLNAT statement to invoke a subprogram in a server Natural.
The Natural client and server sessions may run on the same or on a different computer.

Natural RPC exploits the advantages of client server computing. In a typical scenario, Natural on
a Windows client computer accesses server data (using a middleware layer) from a Natural on a
mainframe computer. The following advantages arise from that:

® The end user on the client can use a Natural application with a graphical user interface.
" Alarge database can be accessed on a mainframe server.

® Network traffic can be minimized when only relevant data are sent from client to server and
back.

The RPC service is designed to produceSuper Natural services for distributed working.Super
Natural RPC generates a Natural RPC subprogram from a Super Natural Transaction. This
NaturalRPC subprogram represents a Naturalobject that is executable in any Natural RPC envir-
onment. A Natural RPC service (subprogram) that was generated from Super Natural is executable
via a Natural RPC server. The RPC client can be in a network or on a local system and is completely
independent.
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| NT (PC), UNIX, Mainframe | | Mainframe

generates

| Automatic Client Stub |

RPC Client RPC Server
Service Routine Service Routine

For further information about RPC, see the Natural Remote Procedure Call (RPC) documentation.

Hints and Limitations

The following points provide information on the RPC service and show which transactions are
not supported:

Before you can start using the RPC service the administrator has to set it up in the user profile.
The RPC service is generated in Natural Reporting Mode.

The RPC service can be used as any Natural RPC service. It contains no Super Natural-specific
information.

For each RPC service generation, the transaction is automatically saved with the Super Natural
command keep.

You can only use Report Transactions to generate the RPC service, no Data Maintenance Transactions.

Transactions, defined with report type Tabular or CON-NECT are not supported by the RPC ser-
vices.

The RPC service Objects are generated to be used with automatic Natural RPC execution. This
requires to set the RPC parameter to AUTORPC=0N. For further information, see the section Stubs
and Automatic RPC Execution in the Natural Remote Procedure Call (RPC) documentation.

The library type is important to meet the requirements of the RPC logon feature that is set on
the client side. For further information, see the section Using the Logon Option in the Natural Remote
Procedure Call (RPC) documentation.
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Dynamic Input Fields within the RPC Service

You can process more dynamic RPC services by using the Super Natural dynamic input fields.
Herewith the client application defines the selection values at execution time when calling the
RPC service.

This requires an additional input structure to be generated for the RPC service. It must be part of
the client interface.

Generate an RPC Service - Server Side

You can use any transaction (except the documented limitations) of your worksheet to proceed
the RPC service.

~ To generate an RPC service

1  Select a transaction out of the transaction list with the MODIFY (mo) command.

The worksheet appears.
2  Enter GENERATE RPC into the command line.

3  Press Enter.

The following window with the default settings appears:

RPC-Service Generation

The RPC Service will be stored with

Object Name ........... RPCSMPL1
in Library ............ NSNSAMPL
with Generation Mode .. Direct
and Record Limit ...... 545

Generate with these options
Change options before generation
Modify Transaction

> |

4  Specify how you want to proceed:
Generate with these options

The generation process starts. If the service object to be generated already exists, confirm the
replacement in the appearing window.
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Change options before generation

Modify the RPC service options before starting the generation process. The Modify Generation
Options window appears.

Modify Transaction

Return to the preceding screen to modify the transaction.
5  Select Change Options before Generation.

6  Press Enter.

The following screen appears:

RPC-Service - Modify Generation Options

RPC Service Object Name ........ RPCSMPL1
Library ............ NSNSAMPL

Generation Mode ................ D Direct

Limit of Result Records ........ 545

(Max. possible Result Records .. 545 )

7  Fill in the required information.
RPC Service Object Name

Name of the RPC service Object to be generated. Depends on the user options and can be pre-
defined by the administrator.

Library

Library of the RPC service Object to be stored. Depends on the user options and can be pre-
defined by the administrator.

Generation Mode

Direct or Context. Defines how the Generation will be processed. For further information, see
the section Generation Modes.

Limit of Result Records / Max. possible Result Records

Result record handling. For further information, see the section Result Data Limitations.

8  Press Enter.
The RPC service Object has been generated and is ready to use.

You can control your RPC service by looking at the Natural-Code.
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~ To confirm the replacement of an RPC service

If you want to generate the same RPC service object twice you have to confirm the replacement
of the first.

1  Specity the RPC service Object name in the RPC Options window and press Enter.

The following window apprears:

Confirm Replace RPC Service
The RPC Service RPCSMPLI1
in Library NSNSAMPL
does already exist.
The object will be replaced now.

Enter Y to confirm: Y

2 Confirm the replacement by entering Y and press Enter.
Result Data Limitations

Direct Mode
The number and the length of fields are relevant for the number of records!

Example selected result data:

#FIELD - A|N 8
#FIELD -B |A 1
#FIELD - C|A 20
#FIELD - D|A 20

" results in a record length of 49 Byte
* maximal parameter buffer is 30 KByte

" results in a maximal number of 612 records
Context Mode

The largest field length is relevant for the number of records in the context area (intermediate
storage). The number of records retrieved with one client call has the same limitation as explained
in direct mode but multiple calls can be performed in the context mode.
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Example selected result data:

#FIELD - A|N 8
#FIELD -B |A 1
#FIELD - C|A 20
#FIELD - D|A 20

" largest field length is 20 Byte
" maximal array size for a field in the context area is 32 KByte

® results in a maximal number of 1638 records

Resulting RPC Service Source

The following section gives you an insight into the source of a generated RPC service, explains
the single sections and introduces the naming conventions for input and output parameters.
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Overview of the Source
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Top
0010
0020
0030
0040
0050
0060
0070
0080
0090
0100
0110
0120
0130
0140
0150
0160
0170
0180
0190
0200
0210
0220
0230
0240
0250
0260
0270
0280
0290
0300
0310
0320
0330
0340
0350
0360
0370
0380
0390
0400
0410
0420
0430
0440
0450
0460
0470
0480
0490
0500

%k X o ok X % .

*

*

*

*

> + Subprogram RPCSMPLZ2 Lib NSNSAMPL
B e P PP C P PO SO O T D o PP P A

R R R B R b b b b b S b o O Super Natura] = RPC Servjce Routjne*****************

Subprogram: RPCSMPL?
Author : Super Natural
Date : 2000-10-09

NSN RPC Identification Area - do not touch the '* NRIA.'-lines below

NRIA. RPC YCF IA-SMPL2200010091006048200010091001128CF

DEFINE DATA PARAMETER

01

01

01

01
01
01
01
01
01
EN

*

##FCONTROL
02 #RETURN (N4)
02 #MORE (L)

02 #LIMIT  (N10)

02 #CT-RES (N10)

02 #CT-POS (N10)

02 #CT-PAGE (N5)

02 fMAX (N5) 0210 01 #INPUT
F#FINPUT

02 #BI_DY_NAME-START (A20)

02 #BJ_DY_NAME-END (A20)
FOUTPUT (1:V)

02 #fAF_PRI_FIRST-NAME-1 (A20)
02 ffAE_PRI_SURNAME (A20)

02 #fAL_PRI_STREET-NUMBER (A20)
02 ##AN_PRI_ZIP-CODE (A10)

02 #fA0_PRI_CITY (A20)

02 #fAM_PRI_COUNTRY (A3)

CONTEXT
#AF_CTX (A20/1638)
fIAE_CTX (A20/1638)
#AL_CTX (A20/1638)
#AN_CTX (A10/1638)
#FAO_CTX (A20/1638)
fFAM_CTX (A3/1638)

D-DEFINE

SET GLOBALS LE=0FF

MOVE 1638 TO #CONTROL.#LIMIT

RESET #LOOP-END(L) #fCONTROL.#RETURN

REPEAT UNTIL #CONTROL.#MORE OR #LOOP-END /* Data retrieval loop

MOVE TRUE TO #LOOP-END
RESET #LT-T(P10)
##CT-0UT(P10)
##CT-MAX(P7) = 1638
MOVE #BI_DY_NAME-START TO #BI (A20)
MOVE #BJ_DY_NAME-END TO #BJ (A20)
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0510
0520
0530
0540
0550
0560
0570
0580
0590
0600
0610
0620
0630
0640
0650
0660
0670
0680
0690
0700
0710
0720
0730
0740
0750
0760
0770
0780
0790
0800
0810
0820
0830
0840
0850
0860
0870
0880
0890
0900
0910
0920
0930
0940
0950
0960

PRI. FIND ( 1639 ) SAG-TOURS-E-PERSON
WITH SURNAME = #BI THRU #BJ
SORTED COUNTRY SURNAME
ADD 1 TO #LT-T
IF #LT-T > 1638 DO
MOVE 12 TO #CONTROL.#RETURN
ESCAPE BOTTOM DOEND
* Start: Store parameter
ADD 1 TO #CT-0UT
IF #CT-OUT GT #CT-MAX DO
SUBTRACT 1 FROM #CT-0UT
MOVE 16 TO ffCONTROL.4#RETURN
ESCAPE BOTTOM DOEND
MOVE FIRST-NAME-1(PRI.) TO #FAF_CTX(4#CT-0UT)
MOVE SURNAME(PRI.) TO #AE_CTX(#CT-0UT)
MOVE STREET-NUMBER(PRI.) TO #AL_CTX(#CT-0UT)
MOVE ZIP-CODE(PRI.) TO #AN_CTX(#CT-0UT)
MOVE CITY(PRI.) TO #fAO_CTX({CT-0UT)
MOVE COUNTRY(PRI.) TO #AM_CTX(#CT-0UT)
* End: Store parameter
LOOP (PRI.)
LOOP /* Data retrieval Tloop
IF NOT #CONTROL.#MORE MOVE #CT-OUT TO #CONTROL.#CT-RES
* Start: Retrieve from context
RESET CONTROL.#CT-PAGE #CONTROL.{#MORE
REPEAT
ADD 1 TO f*CONTROL.#CT-POS
ADD 1 TO #CONTROL.#CT-PAGE
MOVE #AF_CTX (#fCT-POS) TO ffAF_PRI_FIRST-NAME-1(#CT-PAGE)
MOVE JFAE_CTX (#CT-P0OS) TO fFAE_PRI_SURNAME (#CT-PAGE)
MOVE #fAL_CTX (J/CT-POS) TO fFAL_PRI_STREET-NUMBER(HCT-PAGE)
MOVE #fAN_CTX (#CT-P0S) TO #AN_PRI_ZIP-CODE(#CT-PAGE)
MOVE #fAO_CTX (#fCT-POS) TO fFAO_PRI_CITY (#CT-PAGE)
MOVE #AM_CTX (#CT-POS) TO #AM_PRI_COUNTRY (#fCT-PAGE)
IF {fCONTROL.#fCT-POS GE #CONTROL.ffCT-RES ESCAPE BOTTOM
IF {fCONTROL.#CT-PAGE GE #fCONTROL.{#MAX DO
MOVE TRUE TO #CONTROL.#MORE
ESCAPE BOTTOM DOEND
LOOP
* Start: Final Handling
IF ##CONTROL.#RETURN EQ O DO
IF #fCONTROL.#CT-RES = 0
MOVE 8 TO #fCONTROL.#RETURN
DOEND
* End: Final handling
END
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Parameter Structure
1. CONTROL-Structure
#RETURN (output parameter)

The following return codes are possible:

Return Code | Description

0 All data is transferred without error.

4 Buffer of data is transferred without error; more data available.

This indicates for the direct mode that not all records could be retrieved because of a too
small output array definition at the client side or a result set that is larger than the 30 KB limit.

This indicates for the context mode that more records are available and can be retrieved with
a subsequent call.

8 No data with this selection found.

12 Record limit is exceeded at the primary file.

14 Record limit is exceeded at the secondary file.

16 Result record limit is exceeded. This limit depends on the limitations given by the max. possible

result records and the user settings concerning the limit of result records.

#MORE (input and output parameter)

Flag that shows wether another page can be delivered (TRUE) or wether this is the last page (FALSE).
In direct mode, this parameter is always set to FALSE what means that it is not used.

#LIMIT (output parameter)

Information for the client that indicates how many records can be processed.

#CT-RES (output parameter)

Result-Counter: Indicates how many records were found with the current selection.
#CT-POS (output parameter)

Counter-Position: For each page returned, the counter indicates the number of the last record.
CT-PAGE (output parameter)

Counter-Page: Indicates how many records the current page contains.

#MAX (input parameter)

Is set by the client application to indicate how many records can be retrieved by the dynamic
output array.
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2. INPUT-Structure

Input parameters that have to be defined by calling the service. The parameters used by defining
the transaction can be taken over into the RPC service. They refer to the dynamic input variables
of Super Natural.

Naming Conventions of Input Fields
#<unique identifier>_<dynamic field>_<field name>

Example:

##BT_DY_NAME-START

3. OUTPUT-Structure

Dynamic array. The limit of the array is set by the client. It contains all output fields in the order
as selected in the transaction.

Naming Conventions of Output Fields

The names for the interface fields are set up with naming conventions as described as follows.
Each name can be max. 32 byte.

#<unique identifier>_<field source> <system function identifier*> <multiple fields
or periodic group identifier*>_<field name>

* if used in the transaction

Part of the Name Description
Unique Identifier Super Natural Field Reference
Field Source Possibilities:

® primary file (PRI)

" secondary file (SEC)
= Jookup file (F)

= user field (U)

= work file field (U)

® dynamic variable (U)

" system variable (S)

System Function Identifier Appears only in Summary mode.

Multiple Fields and / or Periodic Group Identifier | Appears only for database arrays.
Field Name Name of the field used.

Example:
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#FAY_PRI_MAX_P2M2_BONUS

Periodic groups and multiple fields are flatterned for the RPC service for performance purposes

as follows:

Elernentary Field Multiple Walue Field
{Marne) {Job Title)

B T

leads to

4" 4"

M,

Ercowm /\/ OEA /\/ Programmer /\/

Overview of the Modes and Options

Generation Modes

Direct Generation Mode

Context Generation Mode

Returns all result data with one call.

Returns the result data with multiple calls (where
conversational RPC mode is required).

The result data amount is limited to 30 KByte
(general limitation for Natural subprogram
parameters). For an example see section RPC
result data.

The result data amount is limited to 32 KByte for every field
(general limitation for Natural arrays). Occurrences of an
output array are treated as single fields. As the result data is
organized in output records, the largest field of the record
defines the number of records of the result data. The result
data retrieved with one call is limited to 30KByte. For an
example see section RPC result data.

All result data is immediately available for
the client. This enables the usage of the RPC
service in local environments for example
testing requirements.

The result data is stored in the RPC-specific context area and
can be retrieved buffer by buffer to the client. No local use of
the RPC service is possible.

Record Limit

The Record Limit informs you about the maximum possible number of records that can be retrieved
by the RPC service. This depends on the generation mode, the used transaction, possibliy used
summary mode and the largest field used in the output data. For an example see section RPC

result data.
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Generation Modes and PRC Conversation Modes

The following table gives you an overview of the Generation Modes and the possible RPC modes.
For further information, see the Natural Remote Procedure Call (RPC) documentation.

Direct Generation Mode

Context Generation Mode

Conversational RPC

Not required for the RPC service itself.
It may be recommended if the Super
Natural PRC service is part of a set of
RPC services to be executed together.

Required for the PRC service to hold the
conversation until all data buffers are
received by the client.

Non-Conversational
RPC

Recommended if the RPC service is
executed as a single.

Not recommended as only the first data
buffer can be received by the client. The
others will be lost because the conversation
is not hold.

Create the Client Side Parameters

The client side parameter structure can be created easily by using the RPC service and the Natural
local data area editor as follows:

~ To create the client side parameters

1 Open the Natural local data area editor by entering the following command: edit 1.

2 Enter in the first editor line the line command . i

3  Press Enter.

The following window appears:

<(your object name)>.
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NAT0082 Invalid command, or object NSN-RPC does not exist in library.

Local Library EXCEL DBID 167 FNR 32
Command >+
I T L Name F Leng Index/Init/EM/Name/Comment

ANl = =======c====ss==c===22=cc====222c = ==== =cc====ss=cccossssscsosssssscooos

i (r-context>!------------------o oo |
Data Area Editor

Please select :

AT11 Tocal variables
Only internally defined local variables
A1l parameters

! I
! I
! I
! I
! I
! AT11 Tocal variables and parameters !
| |
! I
] |
! Only internally defined parameters !
| |

4  Select A11 Parameters.

5  Press Enter.

The parameters are separated from the coding.
6  Save them as a local data area.

7 Export them to the client environment.

Note: Before stowing the local data area, the dynamic #0UTPUT array must be defined by a

concrete value.

Memory Requirements

Super Natural is a Natural application and as such follows the Natural recommendations for ap-
plications. However, because Super Natural generates programes, it is advisable that you follow
the recommendations below when setting your session parameters:
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Buffer Size
DATSIZE |50
ESIZE* |45
RUNSIZE |20

* ESIZE is dependent on the size of the DDMs you are dealing with and the number of fields used.
Some transactions may need larger values than those listed above.

Example

The sample transaction SAMPLE? described in the section Sample Transactions in the User’s Guide
has the following transaction specification:

Primary File SAG-TOURS-E-CRUISE

Display Fields |1A: START-DATE

1B: END-DATE

2: CRUISE-PRICE

3: CRUISE-ID

4: START-HARBOR

5: DESTINATION-HARBOR
6: CHARTER-YACHT-TYPE

Control Fields |1: START-DATE

System Function |Minimum on field CRUISE-PRICE
Sort Field 1: START-HARBOR

Selection Criteria| AT GE 500

The transaction results in the following sizes:

ESIZE 6608 Bytes
DATSIZE 612 Bytes
Buffer Pool 2684 Bytes

Example

The sample transaction SAMPLE3 described in the section Sample Transactions in the User’s Guide
has the following transaction specification:
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Primary File SAG-TOURS-E-CRUISE

User Fields MY -START-DATE
MY-START-YEAR
MY -START-MONTH
MY -START-DAY
MY -END-DATE
MY-END-YEAR

MY -END-MONTH
MY -END-DAY

Display Fields 1: CRUISE-ID

2: START-HARBOR

3: DESTINATION-HARBOR
4A:MY-START-DATE

4B: MY -END-DATE

Selection Criteria CHARTER-YACHT-TYPE ="'ATLANTIC 29'

Calculation Statement MY-START-DATE=MY-START-DAY!"""MY-START-MONTH!".""MY-START-YEAR
MY-END-DATE=MY-END-DAY!""MY-END-MONTH!".''MY-END-YEAR

Logical Conditions Statement|1 I < START-DATE GT 19910701
1T <MY-START-DATE ="TOO LATE
1T<MY-END-DATE=""

The transaction results in the following sizes:

ESIZE 8325 Bytes
DATSIZE 564 Bytes
Buffer Pool 2392 Bytes

Communication with Other Applications

Super Natural can be invoked from any other Natural application and you can invoke any other
Natural application from it.

When Super Natural is invoked from another application, you can ensure that you are returned
to it when exiting Super Natural by using the Natural SETUP command because Super Natural
always terminates with the RETURN command.

Every application which is invoked from Super Natural must terminate with the RETURN command
to ensure that Super Natural is reactivated.
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The Technical Information Function

The Technical Information function provides you with technical information concerning your
environment as in the following example:

18:01 FHxx*% Syper Natural ***** 1999-04-28
SN1110 - Transaction List - Friday
More: 4

Cigl N& dr======================== Techinical ITnTermation======================== 4

* 1 NSN Version ......... 3.3.1 Operating System .. MVS/XA
__ AD ! PersonalDB-File ..... (0,90) TP Monitor ........ COMPLETE !
__ AS ! Device Type ....... PC
AU ! Natural Version ..... 3.1.3 !
__ CH ! PREDICT Version ..... 4.4.1 AQS Version ....... 0.0.0 !
__ CO ! CON-NECT Version .... 0.0.0 NSC Version ....... 3.1.3

Cco ! !
__ CO ! Buffer Sizes: Esize .. 35 k DATsize ... 45 k Usize .. 31 k !
__ co! Fsize .. 20 k SORTsize .. 10 k Csize .. 1 k
o ! |
__ CO ! Last Error Number ... 1 !
__ DA ! Last Error Program .. Last Error Line ... 34 !
DA ! |
Add __ ! Program: was cataloged at !

| |
Cmd(s): 4= - +
Command ===
BieEr=PEIL == = PIFZ2= = = PEg= = = [PFdl= = = PEE = = = PIEE = = = [PIE7/= = = [PIEg)= = = [P[RC)= = = PIET|(0)= = [PIEIL Il = = PIFI 2= = =
Help Exit Flip Canc

If you phone Software AG Customer Support because an error has occurred, you may be asked
to enter a Super Natural module number in the Program field to obtain cataloging information.

The Technical Information function is always available.

Layout Members

When you save, run or execute a transaction, a copy code layout member is created with the name
Tayout-prefix transaction-name. When you keep a transaction, a layout member with dummy
copy code is created. Before you have kept, saved or run a transaction, thename transaction-name
is reserved for its layout member. You only see the work-in-progress layout name in exceptional
cases (after power cut etc.).
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Passwords and Cipher Code

If Adabas security is being used, passwords or cipher codes can be set either for users or for files
in the Super Natural Administration application. The passwords and cipher codes are read from
the user profile each time a transaction is modified. Because this does not take place at run time,
security errors caused by password changes may occur if a transaction is not regenerated.

User Profile, Option and Adabas Password Hierarchies

User Profile Hierarchy

The administrator defines which files a user may use and specifies settings for profile, layout and
options. The user can modify certain options and defaults from the Modify Profile screen in Super
Natural Processor. The user can only modify options he is authorized to use. The user-defined
profile overrides the profile set by the administrator. The user can also override his own user-
defined profile just for the current transaction using the OPTIONS and MODES commands.

1

Options and hodes
ifor Trnsaction)

2
| Profile fset by User) |

3

| Profile (et by Admic statr ‘

Option Hierarchy

Options set for a file in the file profile override options set for a file in a user profile.

When you add (link) a file to Super Natural, the file has no option settings and no user list. The
individual file settings which are part of each user profile are valid for users when accessing this
file if you leave the options settings and/or the user list blank.
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1

| Options Set i Fle Pmfie

2

Optons Set n User
P file

Adabas Password Hierarchies

Adabas passwords control file access. The hierarchy of Adabas passwords is as follows:

1

UserperFie

2
| Fie |

| Usar ‘

Passwords on upper levels have priority and are used if provided.

When an Adabas password is provided, it is generated for each transaction program or prototype
program (except for those which access user files) as a Natural PASSWORD statement. When a program
containing a PASSWORD clause is modified, the password entry that is active at modification time
is used.

Adabas passwords and cipher codes affect existing transactions.
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